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AEC1(a): BASIC COMPUTER SKILLS 

Hours Per Week: 2          Credits: 2 
Exam Hours: 1 ½ Hours        Marks: 40U+10I 
 
Objective: to impart a basic level understanding of working of a computer and its usage.  
 
UNIT I: UNDERSTANDING OF COMPUTER AND WORD PROCESSING:  
Knowing computer: What is Computer, Basic Applications of Computer; Components of 
Computer System, Central Processing Unit (CPU), VDU, Keyboard and Mouse, Other 
input/output Devices, Computer Memory, Concepts of Hardware and Software; Concept of 
Computing, Data and Information; Applications of IECT; Connecting keyboard, mouse, monitor 
and printer to CPU and checking power supply.  
Operating Computer using GUI Based Operating System: What is an Operating System; 
Basics of Popular Operating Systems; The User Interface, Using Mouse; Using right Button of 
the Mouse and Moving Icons on the screen, Use of Common Icons, Status Bar, Using Menu and 
Menu-selection, Running an Application, Viewing of File, Folders and Directories, Creating and 
Renaming of files and folders, Opening and closing of different Windows; Using help; Creating 
Short cuts, Basics of O.S Setup; Common utilities.  
Understanding Word Processing: Word Processing Basics; Opening and Closing of 
documents; Text creation and Manipulation; Formatting of text; Table handling; Spell check, 
language setting and thesaurus; Printing of word document. 
  
UNIT II: SPREAD SHEET, PRESENTATION SOFTWARE & INTRODUCTION TO INTERNET, 
WWW AND WEB BROWSERS: 
Using Spread Sheet: Basics of Spreadsheet; Manipulation of cells; Formulas and Functions; 
Editing of Spread Sheet, printing of Spread Sheet.  
Basics of presentation software: Creating Presentation; Preparation and Presentation of 
Slides; Slide Show; Taking printouts of presentation / handouts.  
Introduction to Internet, WWW and Web Browsers:  
Introduction to Internet: Basic of Computer networks; LAN, WAN; Concept of Internet; 
Applications of Internet; connecting to internet; What is ISP; Knowing the Internet; Basics of 
internet connectivity related troubleshooting.  
World Wide Web: Search Engines; Understanding URL; Domain name; IP Address; Using 
egovernance website.  
Web Browsing: Software, Communications and collaboration: Basics of electronic mail; 
Getting an email account; Sending and receiving emails; Accessing sent emails; Using Emails; 
Document collaboration; Instant Messaging; Netiquettes.  
 
SUGGESTED READINGS:   
1. Introduction to Computers, Peter Norton, Mc GrawHill , 2012.  
2. Using Information Technology, Brian K Williams, Stacey C.Sawyer, Tata Mc GrawHill.  
Web Resources:  
1. https://online.stanford.edu/courses/soe-ycscs101-sp-computer-science-101 
2.https://www.extension.harvard.edu/open-learning-initiative/intensive-introduction- 
computer-science. 
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Unit-I 
Knowing Computer 

1. Define Computer? Explain Characteristics and limitations of 
computers? 

Computer: It is an electronic device which is used to take input from the user and process it, 
and produces result as output 
 It is a fast and accurate electronic data processing machine capable of performing 
arithmetic and logical operations. 
Features of Computer: 
• Speed : Computer processes the data at an unimaginable speed. The speed of the computer 

ranges up to nanoseconds. 
• Storage : Computer can store huge amount of data in a secured way. 
• Accuracy : Accuracy of the computer is very high. Accuracy of the computer depends on 

user data. 
• Deligence : Computer never gets tired. If we work it for 24 hours also it works with same 

speed and gives accurate result. 
• Versatility: Computers are versatile machines. They are capable of performing multiple 

tasks at a time. 
Disadvantages: 

• Lack of common sense 
• Depends on human instructions 
• Full proof information should be given 
• Inability to correct. 

2. Explain various applications of Computer? 
Basic applications of computer: 
Desktop publishing: With desktop publishing, you can create page layouts for entire books on 
your personal computer. 
Mathematical Calculations: Thanks to computers, which have computing speeds of over a 
million calculations per second we can perform the biggest of mathematical calculations. 
Banks: All financial transactions are done by computer software. They provide security, speed 
and convenience. 
Travel: One can book air tickets or railway tickets and make hotel reservations online. It 
reduced the time wastage and travel time for everyone. 
Telecommunications: Software is widely used here. Also all mobile phones have software 
embedded in them for maintaining customer details and also sending message, audio and video 
through the mobile software. Now a day's internet is available in the mobile phone itself. 
Defence: There is software embedded in almost every weapon. Software is used for controlling 
the flight and targeting in ballistic missiles. Software is used to control access to atomic bombs.  
E-Learning: Instead of a book it is easier to learn from E-learning software.It not only contains 
text also contain image and animation so it is very easy to understand every thing.  
Examinations: We can give online exams and get instant results. You can check your 
examination results online. 
Computers in Business: Shops and supermarkets use software, which calculate the bills. 
Taxes can be calculated and paid online. Accounting is done using computers. One can predict 
future trends of business using artificial intelligence software. Software is used in major stock 
markets. One can do trading online. There are fully automated factories running on software.  
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3. Explain Block Diagram of Computer or Logical Architecture of 
Computer? 
The following diagram is called as logical architecture and framework of working functionality 
of computer System. 
Which is also called as Block Diagram of Computer, which include input, output, 
components of CPU. 

 
Input Devices: The data that is given to the computer is called as input. The devices which are 
used to take input are said to be input devices. Some of the input devices are Keyboard, Mouse, 
Joystick, Scanner, Webcam. Lightpen etc… 
CPU : CPU stands for Central Processing Unit. It carries the task of processing. It can also be 
called as “Heart” or “Brain” of the computer. It has three sub-units. 

• ALU 
• Control Unit 
• Memory Unit 

ALU : ALU stands for Arithmetic and logical unit. It performs all arithmetic operations (+, - , * , 
/), comparison operations (< , >, <=, >=, =) and logical operations (and, or, not). 
Control Unit : Control Unit controls the processing. It has the data bus to carry the data from 
one unit to another unit. Control unit also controls all the hardware devices. 
Memory Unit: Memory unit is used to store the data. It has two units.  
• Primary Memory 
• Secondary Memory 

Memory Measurement : Computer memory is measured in bits and bytes. A bit means a 
binary digit. It may be 0 or 1. 

4 bits = 1 Nibble 
8 bits =  1 byte 
1024 bytes = 1 Kilo Byte (KB) 
1024 KB = 1 Mega Byte (MB) 
1024 MB = 1 Giga Byte (GB) 
1024 GB = 1 Tera Byte (TB) 
1024 TB = 1 Peta Byte 
1024 PB = 1 Exa Byte (EB) 
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1024 EB = 1 Zeta Byte (ZB) 
1024 = 1 Yeta Byte (YB) 

Primary Memory: It is used to store the data or program during execution. It has two sub-
units RAM, ROM 

 
Secondary Memory : It is a supporting memory for any computer. The information can be 
stored permanently in this memory. It includes 

• Floppy Disk 
• Hard Disk 
• CDs 
• DVDs 
• Magnetic Disk 
• Optical Devices 
• Punched Cards 

Output Devices : The information that is received from the computer is an output. The devices 
which are used to receive output are said to be output devices. Some of the output devices are 
Monitor, Printer, Speaker, Plotter. 
 

4. Explain Various Components Associated with computer system ? 
Components of computer system: 
There are four major components of a computer system 

1) Hardware 
2) Software 
3) Data 
4) user  

Hardware: The physical components of a computer that we can see and touch.  
Input devices, Output devices, Processing device 

INPUT DEVICES: 
The most common input devices are:- 

1) Keyboard: -   Key board is the primary input device for entering the text is the primary 
input device for entering the text and numbers. It is a simple device consisting of 101 Keys. The 
keyboards for personal computers com in number of styles and also in different size and shape. 
The most common keyboard layout used today was designed by IBM (International business 
machines). The keyboard keys are arranged in 5 groups. 
a) Alphanumeric keys: - The parts of the keyboard that look like a type writer machine are 
arranged in a common manner. This arrangement is called “QWERTY” layout because the first 
6 keys on the top of letters are Q, W, E, R, T, and Y…  
b) Modifier keys: - This key is used in combination with other keys. The modifier keys are 
Shift, Alt, (Alternate), Ctrl (Control). 
(c) Numeric pad: - This key is located on the right side of the keyboard. It looks like a adding 
machine (calculator) with 10 digits and the mathematical operators like addition (+), 
subtraction (-), multiplication (*), division (/), 
(d) Function keys: - The functions are usually arranged on the top of the row of the keyboard. 
The function keys are from F1 – F12. They allow the user to give the computer commands 
without having to type long strings of the characters. The most common function key F1 is used 
to help in all the programmes. 
(e) Cursor movement keys:- This are the set of four keys which allows the user to change the 
position of the cursor on the screen. The cursor movement keys of the cursor on the screen. 
The cursor movement keys are right, left, top, and bottom.↑ ← → ↓ 
2) Mouse: - A mouse is an input device that roles around a flat surface or on a desk and 
controls the pointer. The pointer is on-screen object usually an arrow (↑) mark that is used to 
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select the text, access menus, moves files and interacts with other program files, or data that 
appear on the screen. A mouse also allows the user to create graphic representations, drawing 
lines, curves and free hand-shapes. Clicking, double clicking, right clicking and dragging are the 
four major operations performed with the help of mouse. 
3) Track ball: - A track ball is a pointing device that works like a upside down mouse. The 
move the cursor around the screen the user rolls the ball with the help of a thumb. The track 
balls such as “Trackman” from the Logitech Company are not even attached to the computer. 
They act like a remote controller for the pointer. 
4) Track pad: - The track pad is a stationary pointing device. The movement of a finger across 
a small touch surface is translated in to cursor movement on the computer screen. The surface 
is just 1.5 to 2 inches square and it is well suitable for the laptop computers and note book 
computers. 
5) Light pen: - The light pen is also called as stylus. Pen – based systems uses electronic pen as 
their primary input device. Pen is used to write or select the objects on a special pad or directly 
on to the screen. Pen is also used as a pointing device like a mouse to select commands.  
6) Touch screen: - The touch screens allow the user to point directly at the computer screen 
usually to select the menu of choices which are displayed on the screen. The touch screens uses 
sensors in the screens are mostly used of a finger. Touch screens are mostly used in ATM 
banks, Railway reservation counters etc…  
7) Barcode readers: - The barcode readers convert the barcode image into a number. It enters 
the number into the computer. Barcode readers are used in super markets, departmental 
stores etc… 
8) Image scanner and optical character recognition: - Image scanners can convert any 
image into electronic form by using shining light (laser) on to image and sensing (reading 
intensity of the light at every point of reflection. A Software is used to translate the image into 
text is called as optical character recognition. Two types of scanners are available they are 
hand held and flat bed… 
9) Game controller: - A game controller is an input device because a computer game is a 
program. Joystick is used to play the games on the computer. 
10) Microphone and voice recognition: - Sound is mostly used in multimedia applications. A 
sound card is used to translate the electronic signals from microform into a digital form. The 
computers can understand, store and process the sound with the help of voice recognition 
software. 
Output devices 
The output devices of a computer are:- 
a) Monitor 
b) Printer  
c) Plotter 
d) speakers 
e) projectors 

a) Visual Display Unit (Monitor): - Monitor is a common output device. There are two 
types of monitors available in the market they are:- 

1) Cathode ray tube (CRT)  
2) Flat panel display 

1) Cathode ray tube (CRT):- CRT can be monochrome (single color) displaying only one color 
against a contracting background. In the monitor there is a electronic gun which shoots a beam 
of electrons through a magnetic oil. It is coated with phosphorous which glow when they are 
struck by electronic beam. The smallest number of phosphorus allots is called a “pixel”.  
2) Flat panel display: - These monitors provide brightest and clearest picture. These monitors 
are relatively low cost in maintenance. These monitors are becoming more popular because of 
their light-weight and in small size. There are several types of flat panel monitors. The most 
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common liquid crystal display (LCD). The L.C.D. monitors create images with special kind of 
liquid crystal that is normally transparent. These monitors became opaque when electricity 
passes through them. The L.C.D. are also used in calculators and digital watches and so on.  

 
b) Printer: - Printers used to take the output on to a paper. The printers are divided into two 
categories they are:-  

(I) Impact printers: - It creates an image by pressing an inked ribbon against the paper 
by using pins hammer is embraced consist with the shape of alphanumeric character. 
The shape is transferred through the inked-ribbon on to the paper, resulting in a 
printed character. The most common impact printers are dot matrix printer, line 
printers and band printer. 
(II) Non impact printers:- These printers creates an image by using tiny nozzles to 
spray droplets of ink on to the page. The non impact printers are inkjet printers and 
loser printers. 

A) Dot matrix printers:- A dot matrix printer creates an image by using a 
mechanism called as print head which contains a cluster (matrix) of shot pins 
arranged in one or more columns on receiving the instructions from the CPU the 
printer pushes out the pins in various combinations then the print head creates 
alphanumeric character. The pins strike the ribbon and the matrix is pressed onto a 
piece of paper. When a single pin strikes the ribbon a single dot of ink is printed 
printer. The lowest resolution of dot matrix printer has 24 pins. The dot matrix 
printers are commonly used in date processing departments which produce large 
reports. The dot matrix printers are measured in character per second (CPS). The 
shortest printer creates 70 characters per second and the highest printer creates 
more than 500 characters per second. 
B) Inkjet printers: - These printers create on image directly on the paper by 
spraying ink through tiny nozzles. The print resolution of inkjet printers are 360 
dots per ink. 

These printers are less expensive and they are available in color as well as black 
and white. These printers have low operating costs and also offer good quality and 
speed. 
C) Laser printer: - Laser printers are more expensive than inkjet printer because 
quality is higher and faster. A separate CPU is built into the printer to process the 
data that it receives from the computer and also to control the laser printer.  

The laser printer consists of a toner which is composed of tiny particles of 
opposite charge. The ink sticks to the drum in the places where the laser has charged 
with pressure and heat. There are two types of laser printers. They are single 
column (B/W) and multiple colors. The Single color prints 4 to 16 pages per minute 
and they have the resolution from 1200 to 1800. The color printer works faster than 
the B/W printer at least 4 times much faster. 

c) Plotter: - A plotter is a special kind of printer, which produces large drawings or images. It 
uses a robotic arm to draw the images on the paper. The plotters are used to take the printer of 
large images such as banners, wall posters and flex-boards etc… 
d) Speakers:-Speakers are another type of output device, which allows you to listen to voice 
like music, and conversation with people. 
e) Projectors:- A projector is an output device that can take images generated by a computer 
or Blu-ray player and reproduce them by projection onto a screen, wall, or another surface. In 
most cases, the surface projected onto is large, flat, and lightly colored. For example, you could 
use a projector to show a presentation on a large screen so that everyone in the room can see 
it. 
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3) Software : It is a set of programs which makes to function the computer. 
Program : It is a set of instructions given in a sequential order to solve a given problem. 

Software Types :  
• System Software : The Software which is applicable to a system or hardware is called 

System Software. 
Eg : Operating System, Device Drivers, Compiler, Interpreter 
• Operating System : It is a set of programs which controls all the activities of the 

computer. It acts as an interface between the computer and the user. 
• Device Drivers : Allows the device to communicate with the system.  

• Application Software : The software which is applicable to a particular application is 
called as Application Software. 

• Eg : Bank Software, Library Management Software, Reservation Software, Hotel 
Management Software… 

4) Data:  It is a collection of raw facts. It consists of alphabets from a-z, numerals from 0-9 and 
special characters. The word data was derived from a latin word called “DATUM”, 
which means collection of something. 

5) User: The one who will work on the system is called as user example 
 Programmer (software developers) 
 DBA’s 
 End user 
 Testers 

 

5. Define Memory Explain types of Memories? 
Primary Memory: It is used to store the data or program during execution. It has two sub-
units:  

• RAM 
• ROM 

RAM (Random Access Memory) : 
• It is read and write memory 
• It is a volatile memory i.e., erasable memory (if power goes off or system is switched off 

the contents of memory will be lost) 
• It does not have necessary commands to start the computer.  

ROM (Read Only Memory) 
• We can just read the data present in this memory but we can not store the data. 
• It is a non-volatile memory i.e., non-erasable memory (if power goes off or system is 

switched off the contents of memory will not be lost) 
• It has necessary commands to start the computer and configuration particulars of all the 

peripherals. 
Secondary Memory : It is a supporting memory for any computer. The information can be 
stored permanently in this memory. It includes : 

• Floppy Disk 
• Hard Disk 
• CDs 
• DVDs 
• Magnetic Disk 
• Optical Devices 
• Punched Cards 

 

6. Discuss Various Secondary Storage Devices? 
STORAGE DEVICES 
 The two main categories of storage devices are:- 
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(I) Magnetic storage devices.  
(II) Optical storage devices. 
(I) Magnetic storage devices: - The various types of magnetic storage devices are :-  
A) Floppy disk 
B) Hard disk 
C) Magnetic disk and 
D) Magnetic tapes 
A) Floppy disk: - The magnetic media that helps to store the data on the floppy or read the 
data from the floppy disk. It is small & flexible device. These are single sided or double sided 
and depends upon the storage of the data. The floppy disk is divided into tracks and sectors 
which helps the user to store the data. The storage capacity of each sector is 512 bytes. Floppy 
disks are available in two sizes such as 5 ¼. Inches and   3 ½. Inches. The 3 ½. Inches floppy 
can store 1.4 MB of data and extra high density floppy can store 2.88 MB of data.  
              There is a hole at the centre of the floppy which allows the floppy to rotate. There is 
write protected notch. This is used to protect the valuable information present on the floppy 
disk. It also saves the data from accidental damage. The notch is covered with sticker, the data 
cannot be allowed into the floppy as well as the data can’t be deleted from the floppy. It also 
protects the virus from entering into the floppy disk. The main advantage of floppy disk is 
transferable from one place to another place and the data can be written and also deleted 
number of times. 
B) Hard disk: - Hard disk is a non-removable magnetic media which is used to store large 
amount of data. A hard disk includes one or more plotters present on a central spindle. Each 
plotter is made up of aluminum metal and coated with magnetic oxide. The area of hard disk is 
divided into number of tracks and sectors. The hard disk found in most personal computers 
rotate(spin) between 3,600 rpm to 7,200 rpm. (Revolution per minute). The latest hard disk 
will rotate at the speed of 10,000 rpm. The storage capacity of the hard disk is measured in 
bytes and the latest hard disk in bytes and the latest hard disk available in the market can store 
up to 320 GB of data. 
C) Magnetic disk: - The magnetic disk is a flat circular disk made up of aluminum metal & 
coated with magnetic material like ferric oxide or chromium oxide. The circular plate will 
rotate at constant speed. We can store the data in a magnetic disk either single side or double 
side. The surface of the magnetic disk is divided into number of sectors. The storage capacity of 
a magnetic disk is around 100 MB to 250 MB. 
D) Magnetic tapes: - The magnetic tape devices can provide only serial access and recording 
medium in a plastic tape coated with magnetic material on one side. The recording can be done 
only on coated side. The width of the tape is 1.27 cms and its length is 731.5 mts and the 
diameter of the tape is 25.4 mts. There is a write protected ring at the backside of the tape. A 
small portion of 3 to 5 mts of the tape because we can’t record the information in that area. The 
reading or writing of information is done through a mechanism called as ‘caps tom’ There are 
rollers present in caps tom’s which rotate at constant speed. The storage capacity of magnetic 
tapes ranges from 650 MB to 700 MB of storage area. 
II) Optical storage device: - The most popular alternative devices available are optical storage 
devices. The most widely used optical storage devices are compact disk (CD) the different types 
of compact disk are:- 
A). CD-Rom 
B). CD-Readable  
C). CD-Rewritable 
D). DVD-Rom 
E). Photo-CD 
A). CD-Rom:- CD- Rom stands for compact disk read only memory. It is used to listen the music 
as well as read the data which is present in the CD. Laser beam is used to read the data. Data is 
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present in O’s and I’s. A circular spot from the laser beam to the sensor is represented as ‘1’, 
and the ray which is reflecting back to the sensor is represented as O’. The CD-Rom reads the 
data at the rate of 5 to 15 MB per minute. The storage capacity of a CD-Rom is around 650 MB 
to 700 MB. 
B). CD-Readable/Recordable: - CD-R stands for compact disk recordable memory. It is used 
to record the data. CD-R drove allows the user to create our own CD-R disk that can read to any 
CD-Rom drive after the information have been written on a CD, the information cannot be 
changed nor deleted. The storage capacity of CD-R is 650 MB to 700 MB. 
C) CD-Rewritable: - CD R/W stands for compact disk rewritable. The user can write the data 
or store the data number of times. The data can be a text or music or graphics etc; the storage 
capacity of CD-R/W is around 650 MB to 700 MB. 
D) DVD-Rom: - DVD-Rom stands for digital video disk read only memory. It is a high density 
medium and it is capable of storing a fuel length movie on a single disk. DVD-Rom also looks 
like a CD-Rom. We can also store the data on one side or two sides. Each side of a standard 
DVD-Rom can store the data up to 10 GB and on two sides. It can store the data up to 20 GB.  
E) Photo-CD: - A photo-CD is popular form of recordable CD which is developed by Kodak 
Company for storing the photographic images on a CD. Many film developing industries user 
the photo-CD to store the photos. 

 

7. Define computing, Data and Information? 
 The term Computing refers to using of available computer technology to complete a 
task. Computing may encompass the design and development of software and hardware 
systems for a numerous purposes - often structuring, processing and managing any kind of 
information.  
Data: Data is any collection of numbers, characters or other symbols that has been coded into a 
format that can be input into a computer and processed. 

 Data on its own has no meaning, or context. 
 There are many types of data 
 All data ends up being stored as a series of numbers inside the computer. 
 Data can be input to the computer by the user in many different ways.  
 The main types of data that can be input into a computer and processed are numeric, 

text, dates, graphics and sound. 
Information: Information is processed data. It has a meaning in real world, it is used to take 
decisions in time by the users. 
For the decision to be meaningful, the processed data must qualify for the following 
characteristics 

Timely − Information should be available when required. 
Accuracy − Information should be accurate. 
Completeness − Information should be complete. 

 

8. Explain the various Applications of IECT? 
IECT stands for Information Electronics and Communication Technology. The applications of 
IECT are E-governance, Multimedia and Entertainment 
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Government-to-Business/Consumer (G2C) 
G2C model applies the strategy of customer Relationship Management (CRM) with business 
concept. By managing their relationship with citizen, government can provide the needed 
products and services fulfill the needs from customer/citizen. 
Government-to-Business 
(G2B) is the online non-commercial 
interaction between Government and 
people to provide business information 
and also advice about e-business. 
 

Government-to-Government 
(G2G) is the online non-commercial 
interaction between Government 
Departments / Authorities and other 
Government / Departments. 
Government-to-Employees (G2E) 
This is the best and effective way of 
online interactions between 
government and employees. 
 
Multimedia and Entertainment 
When more than one medium is used 
for Interaction/Presentation, is called 
multimedia. There is number of examples like TV, Computer etc. Having audio and visual 
medium for the presentation. It is a combination of media used for creating Graphics, 
Animation, Text, Sound, image, full motion video, interactive features etc. This is an exciting 
new field for those interested in Computes, technology. It can be accessed through 
computers/Electronic device and integrates the various forms together.  

 
Multimedia Categorization 
It is divided into two categories linear and non-linear. Linear active content progresses often 
without any navigational control for the viewer such as a cinema presentation. Non-linear uses 
interactivity to control progress as with a video game or self-paced computer based training. 
Multimedia presentations can be LIVE or Receded. A Recorded presentation may allow 
interactivity via a navigation system. 
Characteristics of Multimedia 
It can be viewed on stage; Television may be a live or recorded multimedia representation. 
Recordings can be either analog or digital electronic media technology. Digital online 
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multimedia may be downloaded. YouTube is Streaming multimedia. Multimedia games and 
simulator may be used in a physical environment with special effects, with multiple users in an 
online network, or locally with an offline computer, games system, or simulator. You can find 
Multimedia application in various areas like Advertisements, Entertainment, Engineering, 
Medicine, Mathematics, Business, Art, Scientific research education. 
 

9. Explain the process of Setting up of a new computer? 
(OR) 

    Explain the process of connecting Keyboard, Mouse, Monitor, 
printer to CPU? 
 To Set up the computer the computer, you should have at, the minimum power 
cords, CPU, monitor or display device, mouse, and keyboard. 
 Set the computer monitor on the desk and put the computer on or next to the desk. Most 
often, the computer sits on the floor or on a shelf next to the desk or table. However, some 
computer desks offer a small cabinet for the computer. Place the mouse and keyboard that 
came with the computer on the desk or table, in front of the monitor. 
Connect the cables: 
Monitor 

The monitor data cable will plug into the computer in 
only one place. Most monitors will use either a DVI, VGA, 
or HDMI connector and plug into the corresponding port on 
the back of the computer. If your monitor only has a VGA plug 
and your computer only has a DVI connection, or vice versa, 
you need a video converter to connect your monitor. 
 
After the data cable has been connected to the computer, 
connect the power plug from the monitor to the surge 
protector. 
 
Keyboard and mouse 

The keyboard and mouse usually connect to the computer with the 
same type of connector, being either a PS/2 or USB connector. These 
connectors are usually found closer to the top of where all the connectors 
are located on the back of the computer. 
Computer power cord 

For the computer, find the power cord and plug one end into the back of the computer 
itself (only one end will fit), usually at the top or the bottom. Plug the other end of the power 
cord into a power outlet. We highly recommend that both the computer and monitor be 
powered through power outlet.  
 
Note: If your house experiences frequent power fluctuations, consider using a UPS to help 
protect your computer. 
Speakers 

If you have computer speakers, they can also be plugged into the back of the computer. 
The speakers connect to the line out or sound out port (usually green) on the back of the 
computer. If your speakers are powered speakers, the power cord should also be plugged into 
the surge protector 
Adding a printer 

A computer printer does not work until you install the included drivers and software. If 
you have lost the CD for your printer, you can download the drivers for your printer and use 

https://www.computerhope.com/jargon/d/dvi.htm
https://www.computerhope.com/jargon/v/vga.htm
https://www.computerhope.com/jargon/h/hdmi.htm
https://www.computerhope.com/jargon/v/videoconv.htm
https://www.computerhope.com/jargon/p/powecord.htm
https://www.computerhope.com/jargon/p/ps2.htm
https://www.computerhope.com/jargon/u/usb.htm
https://www.computerhope.com/jargon/p/powecord.htm
https://www.computerhope.com/jargon/o/outlet.htm
https://www.computerhope.com/jargon/u/ups.htm
https://www.computerhope.com/jargon/s/speaker.htm
https://www.computerhope.com/jargon/l/lineout.htm
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the drivers to install your printer. A listing of printer manufacturers and links to their 
associated drivers pages are on our printer drivers page. 
Connecting the printer to the computer 

Connect the printer to the computer either using a USB cable, parallel port cable, or SCSI 
cable and then connect the power plug to a power outlet. Today, most all home computer 
printers are using a USB cable similar to the example picture. 
 
Setup printer and install software 
Every printer should come with the software used to install a printer in Windows or your 
operating system. 

1. After everything is plugged in, turn the computer on. 
2. Insert the CD that came with the printer. If the CD does not automatically start, 

open My Computer, double-click on the CD drive, and then click 
the Setup or Install file. If you have downloaded the drivers, run the downloaded 
setup file. 

3. Follow the installation wizard and once completed, your software is installed.  
4. Test the printer to make sure it is working. 

Computer with no CD drive 
If your computer does not have a disc drive or you lost the CD, you can download the software 
for your printer from the manufactures printers driver page. Once the drivers have been 
downloaded, you can run the file to install the drivers.  
Turn the computer on 
You can now turn the computer on and allow it to load up into Windows. Depending on where 
you bought the computer, you may need to complete a few final steps of the Windows 
operating system setup. Follow the steps on the screen to complete this and Windows should 
then load fully. 
Booting: It is an activity of loading the Operating System files into the Computer Memory i.e., 
RAM 
 

10. Define Operating System? Discuss functions of operating 
systems? 
Operating System: It is system software which creates an interface between user and 
computer also provides an environment in which user can perform his tasks efficiently. 
Familiarly known as OS. 
Functions of operating system: 

 Memory management 
 User interface 
 Input/output management 
 Information management 
 Process management 

 
The operating system manages a computer's hardware resources, including: 

• Input devices such as a keyboard and mouse 
• Output devices such as display monitors, printers and scanners 
• Network devices such as modems, routers and network connections 
• Storage devices such as internal and external drives 

The OS also provides services to facilitate the efficient execution and management of, and 
memory allocations for, any additional installed software application programs.  

 

https://www.computerhope.com/jargon/m/mycomput.htm
https://www.computerhope.com/issues/ch000250.htm#test
https://www.computerhope.com/jargon/d/download.htm
https://www.computerhope.com/drivers/printers.htm
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The OS consists of many components and features. Which features are defined as part of the OS 
vary with each OS. 

• User Interface: This component allows interaction with the user, which may occur 
through graphical icons and a desktop or through a command line.  

• Application Programming Interfaces: This component allows application developers 
to write modular code. 

11. Explain various types of Operating Systems? 
Types of Operating System : 

A) Based on Interface of OS is categorized into two types 
CUI: character user interface 
GUI : graphical user interface. 

B) Based on user OS is classified into 2 types: 
Single User Operating System : We can handle one system or one application at a time in this 
Operating System 

Eg : MS-DOS, PC-DOS, CP/M 
Multi User Operating System : More than one user can access the same data at the same time. 
Multi User Operating System would be required when a number of applications have to run 
simultaneously. 

Eg : MS-Windows, Linux, Unix. 
C) Based of Technology used OS classified into 4 Categories  

Multi tasking OS: it allows more than one program to run concurrently 
Ex:Unix ,windows. 
Multi processing OS: it supports running a program on more than one CPU or processor. 
Multi programming: it allows more than one program to run alternatively. 
Multi threading: it supports different parts of a single program to run concurrently on 
systems. 
 

12. List out some popular operating systems And their features? 
List of Operating Systems: 

• MS-DOS (Microsoft Disk Operating System) 
• APPLE MACINTOSH 
• MS-WINDOWS 
• UNIX/ LINUX 
• HP-UX 
• Ubuntu 
• Android 

 
MS-DOS : It is a 16-bit operating system, It is a single user, single tasking operating system. 
It provides CUI (Character User Interface), The first version of MS-DOS has written based on Q-
DOS (Quick and Dirty Operating System)  
Microsoft Windows: Microsoft Windows has existed in one form or another since 1985, and it 
remains the most popular operating system for home and office computers. Its latest versions, 
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including Windows 10, are also used on some tablets, and the OS is used on some web and 
number-crunching server computers as well. Computers from a wide variety of manufacturers 
can use Windows. 
Apple Ios: Apple's iOS is one of the most popular smartphone operating systems, second only 
to Android. It runs on Apple hardware, including iPhones, iPad tablets and iPod Touch media 
players. 
Google's Android OS: Android is the most popular operating system in the world judging by 
the number of devices installed. Largely developed by Google, it's chiefly used on smartphones 
and tablets. Unlike iOS, it can be used on devices made by a variety of different manufacturers, 
and those makers can tweak parts of its interface to suit their own needs. 
Apple macOS: Apple's macOS, successor to the popular OS X operating system, runs on Apple 
laptops and desktops. Based in part on the historic family of Unix operating systems dating 
back to research in the 1960s at AT&T's Bell Labs, macOS shares some features with other 
Unix-related operating systems including Linux.  
Linux Operating System: It is open source software, unlike many other operating systems; 
development on Linux isn't led by any one company. The operating system was created by 
Finnish programmer Linus Torvalds in 1991. Nowadays, programmers from all over the world 
collaborate on its open source code and submit tweaks to the central kernel software and other 
programs 
UBUNTU: Ubuntu is a complete Linux operating system, freely available with both community 
and professional support. The Ubuntu community is built on the ideas enshrined in the Ubuntu 
Manifesto: that software should be available free of charge, that software tools should be 
usable by people in their local language and despite any disabilities, and that people should 
have the freedom to customize and alter their software in whatever way they see fit.  
Note: As All Of Us Aware That, We Prefer To Use Windows Operating System Hence Now 
Onwards Our Discussion Is All About Windows 10 Operating System Only 
 

13. Explain the user interface of Windows 10? 
Once you get to the Windows Desktop screen, here are some basic features you will see.  
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Start Button: 
The Start button in Windows 10 is a small button that displays the Windows logo and is 

always displayed at the left end of the Taskbar as shown in above picture. You can click the 
Start button in Windows 10 to display the Start menu or the Start screen. 
            You can right-click the Start button in Windows 10 to display a pop-up menu of 
shortcuts to various features, windows and control panels on your computer. To open any 
one of these items, click the desired command in the pop-up menu that appears. A handy 
shortcut in this menu is the “Shut down or sign out” command.  
Icon: 

An icon is a small graphical representation of a program or file. 
When you double-click an icon, the associated file or program will be 
opened. Icons are a component of most GUI operating systems, including 
Microsoft Windows and Apple macOS X. Icons help users quickly 
identify the type of file represented by the icon. 
Menu:   

A menu is a Collection of programs/commands present in the 
computer to help the user find information or execute a program 
function.  
Task Bar: 
 Task bar will be placed horizontally at the bottom of a screen, 
which consist  Start button, Some Shortcut Icons, and Current Running applications, and 
Notification area along with date and Time. We can access to all this from Task Bar. 
 To minimize and maximize the applications we use minimize and maximize buttons of 
applications. 
 
Minimized/ Maximized(running) applications are available in Task Bar. 
In Windows 10, if an application is active or opened, you will see a green line below its icon. 
Clicking the icon will bring the application window up. 

 
Every open window features three buttons in the upper-right corner. These are used to 
minimize, maximize, or close the window − 
Minimizing means that the window will hide in the Taskbar. 
Maximizing will bring the window to a full-screen size. 
Windows can be moved around or resized as you please − 
To move a window, just click on its Title Bar on the upper side of the window and drag it. 
To resize a window, move your mouse to any corner until you see a double-sided arrow. Then 
click and drag until you reach the desired size. 
Pin Apps to the Taskbar 
The simplest way to customize your taskbar is by pinning various apps and shortcuts to it so 
that you can access them more quickly in the future. There are two ways to do this. The first is 
to open the program, either from the Start menu or an existing shortcut. When the app’s icon 
appears on the taskbar to indicate it’s running, right-click the icon and select the “Pin to 
taskbar” option from the context menu.  
The second way to pin an app to the taskbar does not require the app to be running first. Find 
the app on the Start menu, right-click the app, point to “More,” and then choose the “Pin to 
taskbar” option you find there. You could also drag the app icon to the taskbar if you prefer 
doing it that way.   
Notification area displays, Sound, Language, Internet connectivity 
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14. Explain Using of Mouse(pointing Device)? 
Mouse lets you move the cursor round the screen and then ‘click’ to start a program or 

begin writing in a particular place or open a menu. 
 All desktop computers come with a mouse, and you can use one on a laptop if you don’t 

like the touchpad that’s built into it. 
Douglas Engelbart Invented mouse in 1963, 

the computer mouse has developed over the years and 
now comes in a variety of designs. 

Today optical mouse that use light to detect 
direction are more common. Mouse  can also be 
cordless, making them easier to move. 
Follow these step-by-step instructions to help you 
get to know your mouse 
Step 1: Pick up your mouse and have a look at it. 
Front side of the mouse there are two buttons – left and right. You press or, more correctly, 
‘click’ these to make things happen. 
Most mouse also have a wheel in between the buttons to move up and down the screen – 
technically called ‘scrolling’. 
Step 2: Learn to hold your mouse comfortably. It’s normally held between your thumb and 
little finger like this: 
Step 3: Have a click. Use your index finger to click the left button and your middle finger to 
click the right button: 
If you’re left-handed, you can use the opposite fingers. However, you can also usually change 
the preferences on your computer to swap which buttons do what.  
Step 4:  Try a double-click. This is done quite often on the left button. You have to click twice, 
as quickly as possible. The first click tells the computer that you are in a particular ‘window’, 
and the second click tells it that you’re selecting a button or link or whatever to do something 
in that window. If you click too slowly, the computer just thinks you’re telling it where you are 
again and again, so do click quickly. 
Step 5: It’s time to practise. You’ll find some simple mouse exercises on the SeniorNet.org 
website. To reach them from here, place the cursor over the highlighted ‘simple mouse 
exercises’ above – this is known as a ‘link’ – and click the left button. Did you notice how the 
cursor turned into a little hand when it was over the link? That tells you that you can click on 
that word or phrase to go somewhere else on that website or on the internet as a whole.  
Step 6: Now try a right-click. Just click the right button, paying no attention where the cursor is 
on the screen. A menu will appear, giving you options. Whenever you right-click, it opens a 

menu. If you move your cursor off the menu and left-click, the menu will close. 

Mouse Button Used Action Purpose 

Left mouse button Click Moves the cursor, selects an object, pulls down a 
menu, or chooses a menu command. 

Left mouse button Double-click Runs or opens a file. 

Left mouse button Drag Moves an object, resizes an object, highlights text, 
and highlights multiple objects. 

Wheel mouse button Roll Scrolls up and down a window. 

Right mouse button Right-click Displays a shortcut pop-up menu. 

https://www.seniornet.org/howto/mouseexercises/placemouse1.html
https://www.seniornet.org/howto/mouseexercises/placemouse1.html
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15. Discuss the steps in changing background? 
Desktop Background 
Another component of your Desktop is the Background. This is 
simply an image that appears at the back of your screen. Most 
computers come with a pre-selected background, but you can 
change it to any image you want. 
 
To change the background, follow these steps − 
 
Step 1 − Right-click on the background it will display a popup 
menu, and then choose “Personalize”.  
 
Step 2 − From the Personalization window, choose from a series of pre-selected pictures or 
browse for your own. 

 
After choosing a picture, the Background will change automatically. 
 

16. How to choose and hide Common desktop icons? 
Enabling common desktop shortcuts 
Step 1: Right-click an empty desktop space. 
Step 2: Access the Personalization menu. 
Step 3: Switch to the Themes category through from the left panel. 
Step 4: Follow the link to Go to desktop icon settings. 
Step 5: Select the icons of interest and hit Apply. 
Optional Step: Uncheck the box that Allows themes to change desktop icons so you don’t end 
up repeating the steps above. 
Asking Cortana 
Step 1: Click the Search field in your taskbar (Win + S). 
Step 2: Write down how to Show or hide common icons on the desktop. 
Step 3: Decide and enable what icons you want on your desktop. 
Optional Step: Right-click an empty desktop space. From the View entry, toggle to Show 
desktop icons. Note that this change applies to everything on your desktop. 
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17. Discuss Start Menu and menu Selection? 
In Windows 10, as you’ve probably noticed, the word “Start” doesn’t actually appear on 

the Start menu, as it did for years; now the Start menu is just a square button in the lower-left 
corner of your screen, bearing the Windows logo ( ). But it’s still called the Start menu, and 
it’s still the gateway to everything on the PC.  

If you’re the type who bills by the hour, you can open the Start menu    by clicking it with 
the mouse. If you feel that life’s too short, however, tap the ( )key on the keyboard instead, or 
the ( )  button if it’s a tablet. 
 

Below is an overview of the Windows Start menu found in Microsoft Windows XP and 
Windows 7. If you have Windows 10 Skip down to the Windows 10 Start menu section. 
Left pane : The left pane shows recently started programs, or any pinned program shortcuts. In the 
above example, there is one pinned program separated by a line and then the recently ran programs. 
All programs: At the bottom of the left pane is the All Programs option which displays all programs 
installed on the computer. 
Search: Directly below the All Programs option is the "Search" bar. This useful feature allows you to 
type in the name of the program or file you're looking for and have the results displayed above. 
Right pane: The right pane shows each of the more commonly accessed sections of the computer, such 
as your Computer, Control Panel, Documents, Music, and Pictures. 
Shut down: At the bottom of the right pane is the Shut down button, which allows you to turn the 
computer off. You can also click the arrow next to the Shut down button to switch user, log 
off, restart, sleep, or hibernate the computer. 

18. Explain Status Bar 
A status bar is a graphical control that is usually included as a default part of the 

graphical user interface design of many applications. Its main purpose is to display status 
information and short messages regarding the application or device’s status. The information 
displayed depends upon the application. 

For Example, the status bar of a word processing application can give information on 
the number of words, cursor position and added functionality like the quick access toolbar. In 
the case of Web browsers, the status bar displays information about a webpage’s loading 
progress status or the actions happening after clicking on a hyperlink. A file manager may have 
a status bar that gives details on the count of items, current directory, total size, number of 
items selected and many more. 
File Explorer Status Bar 

 
 
Word Status Bar 

 
 

19. What is Menu Explain Menu Selection? 
A menu is a set of options presented to the user of a computer application to help the 

user to find information or execute a program function. Menus are common in graphical user 
interface elements of Windows or Mac OS 

A menu may have sub menu which is called as fly-out menu, where submenus "flyout" 
from the side when you mouse over or click the main item. 

https://www.computerhope.com/jargon/c/controlp.htm
https://www.computerhope.com/jargon/s/signoff.htm
https://www.computerhope.com/jargon/s/signoff.htm
https://www.computerhope.com/jargon/r/reboot.htm
https://www.computerhope.com/jargon/s/sleep.htm
https://www.computerhope.com/jargon/h/hibernat.htm
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  A pop-up menu appears above the clicked item when the main list is at the bottom of 
the window or screen. A menu may occasionally appear with apparent spontaneity at a random 
location in a window. This type of menu, also known as a pop-up. 
 

A pop-up menu with only two choices, such as Yes/No, is called a dialog box. 
 

19. Explain about Control panel? 
The Control Panel is a section of Microsoft Windows that enables a user to change 

various computer hardware and software features. Settings for the mouse, display, sound, 
network, and keyboard represent a few examples of what may be modified in the Control 
Panel. Below are some examples of how the Control Panel appeared in Windows.  
 

20. Explain Step by step procedure to run an application?  
In Windows, to run a program, double-click the executable file or double-click 

the shortcut icon pointing to the executable file. If you have a hard time double-clicking an icon, 
you can click the icon once to highlight it and then press the Enter key on the keyboard. 

1) If you are having a hard time opening a program because you cannot find the icon in 
Windows 7,  Windows 8, and Windows 10, click Start and type the name of the 
program you want to open. For example, you could type "notepad", "excel", or "word" 
and click the icon in the search results, or highlight the program icon and press Enter. 
If the program does not appear make sure the program has been installed. 

2) In Windows 8 and Windows 10, you can also right-click the icon and choose the 
option pin to taskbar to add the program icon to your Taskbar for easier future access. 

3) If a program is in the Start Menu or Taskbar, it only requires you to click the icon once. 
4) If a program has not been installed in the computer it will not be able to be ran. For 

example, you can only run Microsoft Word or Microsoft Excel if you have installed it on 
the computer. 

21. Explain the process of Creating and renaming of files and 
directories? 
Windows Explorer is an application that provides detailed information about your files, 
folders, and drives. 

1. You can use it to copy, move, and rename files, as well as to perform other tasks related 
to files, folders, and drives.  

https://www.computerhope.com/jargon/d/doublecl.htm
https://www.computerhope.com/jargon/s/shortcut.htm
https://www.computerhope.com/jargon/c/click.htm
https://www.computerhope.com/jargon/h/highligh.htm
https://www.computerhope.com/jargon/e/enterkey.htm
https://www.computerhope.com/jargon/s/start.htm
https://www.computerhope.com/jargon/i/install.htm
https://www.computerhope.com/jargon/r/righclic.htm
https://www.computerhope.com/jargon/i/install.htm
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2. The simplest way to access Windows Explorer is to right-click the Start menu or the 
File Explorer icon and select Explore 

We can perform the following tasks in File explorer 
Selecting icons in File explorer 
 To select one icon just click on it 
 To select the icons in a sequence, select the icon at first end, press and hold the shift key, 

now select the icon at the other end. 
 To select the icons in a random manner, press and hold the ctrl key and select the icons 

To create a new file or folder 
1. In "Windows Explorer”, open the folder in which you want to create a new folder. 
2. On the File menu, point to New, and then click desired file or Folder.  
3. The new file/folder appears with a temporary name.  
4. Type a name for the new file/folder, and then press ENTER. 

To delete a file or folder 
     1. In "Windows Explorer," locate the file or folder     
         you want to delete. 
     2. Click the file or folder. 
     3. On the File menu, click Delete. 

Copying and moving files and folders 
1. Select the icons of files/folders you to copy or move 
2. To copy press ctrl +c or choose Edit | copy or click copy icon on tool bar 
3. To move press ctrl +x or choose Edit | cut or click cut icon on tool bar 
4. Open the destination drive and folder 
5. Now press ctrl + V or choose Edit | paste or click paste icon on the tool bar 

Renaming file or folder 
 Right click on the icon of file or folder and select rename option from top down menu 

and enter new name  

22. Discuss about opening and closing of windows? 
Snap:  

Snap allows you to resize windows quickly, which is especially convenient when you 
want to see two windows side by side. To do this, click and drag the desired window to the 
left or right until the cursor reaches the edge of the screen, then release the mouse. The 
window will snap into place. To unsnap a window, simply click and drag the window down. 
Flip:  

You can use Flip to switch between open windows. To do this, press and hold 
the Alt key on your keyboard, then press the Tab key. Continue pressing the Tab key until the 
desired window is selected. 
Task view:  

The Task view feature is similar to Flip, but it works a bit differently. To open Task 
view, click the Task view button near the bottom-left corner of the taskbar. Alternative, you can 
press Windows key+Tab on your keyboard. All of your open windows will appear, and you 
can click to choose any window you want. 
Showing the desktop:  

If you have a lot of windows open at the same time, it can be difficult to see the desktop. 
When this happens, you can click the bottom-right corner of the taskbar to minimize all open 
windows. Just click it again to restore the minimized windows. 
 

23. Explain the concept of Using Help in windows 10? 
Here are the quickest ways to make Windows 10 help information when something on the 

desktop creates a trouble. In each case, Windows fetches help, either by going online, fetching 
built-in instructions, or leading you to a tutorial built into Windows 10.  
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 Press F1 when on the desktop: Press the F1 key from within Windows or any desktop 
program. 

 Start menu: Click the Start button and click the Get Started tile 
 Question mark: If you spot a little blue question mark icon near a window’s top-right 

corner, pounce on it with a quick click. 

 
 App menu: Click the three little lines in an app’s upper-left corner, choose Settings from 

the drop-down menu, and then click the Help button, if available, on the pane that 
appears along the app’s right edge. 

 
 

24. Explain the procedure of creating Shortcuts in windows 10? 
To create a shortcut, Look for the application which you want to use in the Start menu at 

the. If it’s in the list at drag and drop the application’s shortcut from your Start menu to your 
desktop. You’ll see the word “Link” appear when you’re moving over that icon on the desktop. 
Release the mouse button to desktop shortcut. 

 
To create a desktop shortcut to a file or folder, first, locate the file in File Explorer. Press 

the Alt key on your keyboard and then drag-n-drop the file or folder to your desktop. The 
words “Create Link in Desktop” will appear. Release the mouse button to create the link.  

 
To create desktop shortcuts to websites. With a web page open, drag and drop the icon to the 
left of the address bar—it’s generally a padlock or an “i” in a circle—to the desktop. 
 

25. How to Install an Operating System Discuss the Steps? 
To install the OS on the machine using a CD or DVD, you need to configure your machine 

to boot from the CD/DVD drive. You can change the boot sequence by accessing the computer 
BIOS and setting the CD/DVD drive to be the first boot device. Some computers may also allow 
you to access the boot sequence directly at computer start up, without entering the BIOS, by 
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pressing a specific key on the keyboard. The key to press differs for each computer, but is often 
either the Delete key or one of the function keys at the top. 

If the operating system software came on a USB flash drive, you need to configure the 
computer to boot to a USB device as the first boot device. 

Once the computer is configured to boot to the proper device, the computer should load 
the operating system installation program and guide you through the install process. You will 
be asked questions along the way for configuration of basic settings, like date and time, user 
account name, and if you want to enable automatic operating system updates. Go through the 
installation steps, answering questions and selecting the preferred options. 
Note : If you are installing a newer version of an operating system that is already on your 
computer, the installation process should ask if you want to upgrade. If you do not want to 
install the operating system as an upgrade, you can choose the option to erase the current 
operating system start fresh 

 

26. What is MS Word? Explain Word processing? 
Word Processing is perhaps the most common and comparatively easier application to 

work on any computer. A word processor lets you to change words o, to move whole sections 
of text from one place to another, store blocks of text, align margins all in few seconds.. MS 
Word is an advanced word processing product by Microsoft company.  
Start Word 2007 

1) Click Start button then point to Programs  
2) Select Microsoft office 2007 
3) Select MS Word 2007 from the list  

You will get a screen asshown below: 
PARTS OF WORD WINDOW 
Please see the picture below for a visual image of parts of an active window has: 
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Menu bar  
This is the traditional windows style drop-down menu. When you point to any menu 

title and click once with the mouse, the menu will open displaying all the commands available 
under this menu. Clicking on the desired command would tell Word to execute that command 
.These commands have further sub commands. 
Standard toolbar  

Toolbars contain buttons, drop-down menus and other controls that help you to quickly 
alter the appearance and arrangement of documents by executing a variety of word commands. 
Toolbars are very helpful and convenient in quickly executing commands without having to go 
through menus. The standard toolbar contains icons for basic functions like opening files, 
saving files, printing files, cut, copy, paste etc. 
Formatting toolbar  

This contains icons for changing the look of your text (called “formatting” in computer 
jargon); for example, there are icons for changing fonts, styles, font sizes, text alignment etc.  
Ruler. The Ruler lets you make changes to margins and indents, and helps you create 
document as per dimensions required. 
 

27. Explain the process of creating, opening, saving and closing 
documents? 
Creating a New Document 

1. Click on File Menu 
2. Select and click New option 
3. Otherwise click button on the standard toolbar 

Opening an Existing Document: 
1. Click File Menu 
2. Select and click Open option 
3. Otherwise click button on the Standard toolbar. 
4. Double click on the file from the open window 

Saving a Document 
1. Click File Menu 
2. Select and click Save button. 
3. Otherwise click button o on the Standard toolbar. 

Closing a Document 
1. Click File menu 
2. Select and click Close button. 
3. Otherwise click butt on menu bar. 

 

28. Explain the features of Editing in MS Word? 
Editing Word document 
Cut, Copy and Paste options 
These options will allow you to Cut or Copy a piece of 
text 
from one location and to paste at a new location. 
To do these functions, 
 
1) Place the cursor at the beginning of the text to be 
selected. 
Drag the mouse pointer over the text. 
2) Click Edit menu and then click on Cut option 
(or)ctrl+x (or ) or click on  cut  icon on the Standard 
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Toolbar. Move the cursor to the place where you want the text to be pasted. 
 
3) Click Edit menu and then click Paste option (or) ctrl+v (or) click  on  paste icon on the 
Standard Toolbar. 
 
For copying the text from one location to other location the same procedure is to be followed. 
The difference between Cut and Copy is that while using the Cut option the text will be 
removed from its original location and pasted at a new location, where as when using Copy 
option a copy of the selected text is pasted at new location without disturbing the original text. 
 
Formatting documents 
Bold, Underline and Italicize the selected text 
 
1) Open a word document. 
2) Block the text by first clicking at the start of the text and Holding the left mouse button and 
drag to the desired position and then release the left mouse button. The selected area will  
be highlighted. 
3) Move the mouse pointer to the bold button on the Standard  Toolbar and click once. 
4) Move the mouse pointer outside your text and click to release the highlighting. Your text will 
now appear in BOLD FACE. 
 
Left aligning, centering , right aligning and justifying text 
1) Open a word document. 
2) Block the text by first clicking at the start of the text and holding the left mouse button and 
drag to the desired position and then release the left mouse button. The selected area will  
be highlighted. 
3) Move the mouse pointer to Align Left button on the toolbar and click once. Your selected text 
will be left aligned. 
4) Move the mouse pointer to Align right button on the toolbar and click once. Your selected 
text will be right aligned. 
5) Move the mouse pointer to Center button on the toolbar and click once. Your selected text 
will be centered. 
6) Move the mouse pointer to Justify button on the toolbar and click once. Your selected text 
will be justified. 
Creating Bulleted and Numbered list 
If a list of items are to be numbered automatically it can be done using Numbered List option 
Ex: Microsoft Office consists of 
MS-Word 
MS-Excel 
MS-PowerPoint 
MS-Access 
MS-Outlook 
 
The above text is to be selected with mouse. 
1)Click on the Numbered List button on the toolbar 
2)Move out of the text and click to release the highlighting. 
3)Your text will now look like this 
1. MS-Word 
2. MS-Excel 
3. MS-PowerPoint 
4. MS-Access 
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5. MS-Outlook 
Now re-select the text 

1)Click the Bulleted List button on the toolbar 
2) The numbers should be replaced with bullets as shown below 

· MS-Word 
· MS-Excel 
· MS-PowerPoint 
· MS-Access 
· MS-Outlook 

Indenting Paragraphs 
1) Select a paragraph with the mouse. 
2) Click on the Right (increase) Indent b button on the toolbar. 
3) Leave the highlighting on and click once more on the Right Indent button. 
4) Click once on the Left Indent button. Your text  should now be indented by one Tab 
stop. Each time you click, the paragraph is moved one tab stop. 

Changing case of text 
1) You can change the selected text into either UPPERCASE, lowercase, Title case or  tOGGLE 
cASE 
2) Highlight the text. Select the Format menu option 
3) Choose Change Case option. You will get the dialog box shown below. 

 

 
4)  From the list of options select UPPERCASE to convert lower case into uppercase. 
 

29. Spelling and Grammar Checking of word document 
 
a) Open any word document. 
b) Click Tools menu and then click Spelling and Grammar option. You will get the below dialog 
box. 
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c) Note all words that appear red color in First box are spelling mistakes. If you want to accept 
the suggested word, in the second box click on Change. If not, click Ignore button. You 
can also add a word to the dictionary by clicking on the Add button. 
d) Continue this process until you get the dialog box, shown below: 

 
e)Click OK button. 
f) Save your work when the spell-check is complete, so that the corrections are saved. 
 

30. Explain the Concept of Printing in MS Word? 
Printing document 
Once you complete your document, you may want to print it 
for various reasons. This lesson covers the three basic 
features of printing in Word, including Print Preview, Quick 
Print, and traditional Print. 
 
 
 
 
 
 
 
To preview the document before printing: 

 Click the Microsoft Office button. 
 Select Print Print Preview. The document opens in Print Preview format. 

 
 Click Print to print the document or Close Print Preview to exit the preview 

format and make changes to the document. 
In Print Preview format, you can perform many tasks, including: 
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 Modifying margins 
 Changing page orientation 
 Changing page size 
 Zooming in and out to view various parts of the document 
 Viewing multiple pages 
 Accessing Word Options to change several Word settings 

 
To print: 

 Click the Microsoft Office button. 
 Select Print Print. The Print dialog box appears. 
 Select the pages you want to print—either all pages or a range of pages. 
 Select the number of 

copies. 
 Check the Collate box if 

you are printing 
multiple copies of a 
multi-page document. 

 Select a printer from the 
drop-down list. 

 Click OK. 
To print via Quick Print: 

 Click the Microsoft 
Office button. 

 Select Print Quick 
Print. 

 The document 
automatically prints to 
the default printer. 
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31. Explain Table handling in MS Word? 
 

To create a table using Insert Tables Button 
1) Move the cursor to the place where you want to 
insert the table 
2) Choose tables button from the Standard Toolbar 
3) Drag the mouse to highlight the desired number 
of rows and columns in the tables menu. 
Release the button. An empty table is inserted. 
To create a table using table menu 

1) Choose Insert table from Table Menu . You 
will find a dialog box as shown below: 

2) Now type the 
Number of 
Columns and 
rows as you 
require and set 
column width 
Auto. So that the 
Column with will be equal to the width of the text. Now 
click OK. 

3) An empty table is inserted in the document. Now inserting 
rows, columns, Deleting rows and widening the columns is 
very easy. 

 
Insert Rows: 
1) Place the cursor in the table, where rows are to be inserted 
2) Choose Table and click Insert Rows option to insert rows in 
the table 
Delete Rows: 
1) Select the Row which is to be deleted 
2) Click Table and click Delete cells option. 
In the same way you can do with columns also 

 
 

32. Explain spelling and grammar tool, Thesaurus tool? 
Thesaurus:  

The tools /Thesaurus menu selection gives you possible meanings and synonyms for 
selected words in your documents. This helps you be more precise in your writing. To use the 
Thesaurus, position the cursor in front of a word or highlight it. And Right Click and Then you 
will find a dropdown menu and  select synonyms option select Thesaurus menu as shown 
below . 
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Lists of possible meanings and synonyms are displayed. Pick a desired word so that it is in the 
Replace with Synonym box and click the Replace button to use it. Use the Look Up button to 
find alternate meanings of a selected word in the Meanings box. Click Cancel to exit the 
Thesaurus dialog box without accepting any of the suggested changes.  
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UNIT II 

1. What is spread sheet explain is features, Discuss Features of MS 
Excel? 

Electronic spread sheet stores the information in the memory of the computer, 
performs data manipulation and displays results quickly spread sheet can be saved, moved, or 
printed. It serves the needs of a wide range of computer users. Spread sheet applications 
include preparation of reports, payrolls, bills, income statement6s bud jets, loan analysis, 
inventory control, Investment analysis and production analysis There are many spread she et 
packages and of them Ms-Excel is the most popular. 
Features/advantages of spread sheet 
 Calculation can be done easily & quickly. 
 It produces accurate results. 
 Data in a work sheet can be displayed and manipulated.  
 Data can be converted into graphs. 
 The entire work sheet or part of the work sheet can be printed.  
 It allows the user to carry out “what if” analysis (condition),  
 The data in a work sheet can be transferred to other programs very easily.  
FEATURES OF EXCEL 
Excel is an Microsoft office application. Excel is mainly used for making calculations and 
mathematical works. Microsoft excel is a spread sheet application in which no of sheets we can 
add as per our requirements. In a single sheet, it consists of rows and columns and cells. Every 
cell has different address. It is basically used for payroll, accounts, mathematical and for other 
business purposes. 
Features of Excel:- 

 Hyperlink:-We can link one file to another file or page with the use of Excel. 
  Clip art:- In this we can add images and also audio, video clips can be added here.  
  Charts:- With charts, we can show the products evaluation to the clients. For example 

which product sale is more or less in this month.. 
 Tables:- Tables are created with different fields e.g. -name, age, address, roll no so we 

add a table to fill these values. 
 Functions:- Excel supports different categories of functions like Mathematical,  

Statistical, Date and time, text, engineering and database functions. 
 Images and Backgrounds:- In this we add images and backgrounds in sheet. 
 Macros:- Macros are used for recording events for further use..  
 Database:- We can add database from other sources with data feature. 
 Sorting and Filter:- In sorting we can sort our data and also filter our data so that 

repetitions will be removed. 
  Data Validations:- In data tools there are data validations consolidate etc are used.  
 Grouping:- In this we can use group, ungroup subtotal etc..  

 

2. Explain components of MS EXCEL window? 
Starting Excel 

 To open Microsoft Excel, First click on "Start" button. Next click on All Programs. Now 
click on Microsoft Excel, this will start the program. 

 Alternatively, look on your Desktop for an icon shortcut to Excel, and double-click on it. 
Parts of Excel Window: 
Workbook:  We also call it as a spreadsheet. The Workbook is a unique file created in Excel. It 
consists several worksheets. In Excel we can add up to  255 worksheets.  
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Works sheet: A worksheet is a grid of cells, consisting of 65,536 rows by 256 columns. It holds 
the information such as text, numbers or mathematical formulas- 
Title bar: The Title bar displays both the name of the application and the name of the 
spreadsheet. 
Menu bar: The Menu bar displays all the menus available for use in Excel. The contents of any 
menu can be displayed by clicking on the menu name with the left mouse button.  
Toolbar: Some commands in the menus have pictures or icons associated with them. These 
pictures may also appear as shortcuts in the Toolbar. 
Column Headings: Each Excel spreadsheet contains 256 columns. Each column is named by a 
letter or combination of letters. 
Row Headings: Each spreadsheet contains 65,536 rows. Each row is named by a number.  
Name Box: It shows the address of the current selection or active cell.  
Formula Bar: Displays information entered-or being entered as you type-in the current or 
active cell. The contents of a cell can also be edited in the Formula bar.  
Cell: A cell is an intersection of a column and row. Each cell has a unique cell address. The 
heavy border around the selected cell is called the cell pointer. 
 

3. How  to open,save and close workbooks? 
Create, Open, and Save Workbooks 

The Ribbon button contains all the operations such as : New, Open, Close, 
Save and Save As. 

New: Used to create a new Workbook. 
Open: Used to open an existing file from a floppy disk or hard drive of your computer. 
Close: Used to close a spreadsheet. 
Save As: Used when to save a new file for the first time or save an existing file with a different 
name. 
Save: Used to save a file that has had changes made to it. If you close the workbook without 
saving then any changes made will be lost. 
 

4. Explain manipulation of Data in Excel Cells? 
Selecting cells in Excel to select a cell simply click on it. Another easy way to select the cells 

is dragging with mouse. To select a row click on its row heading, to select a column click on its 
column heading. Some key board short cuts are given below:  

PRESS TO 
CTRL+A Select the entire worksheet 
CTRL+SPACEBAR Select the entire column 
SHIFT+SPACEBAR Select the entire row 

F8 Turn on extending a selection by using the arrow keys 

CTRL+SHIFT+END Extend the selection to the last used cell on the worksheet 
(lower-right corner) 

CTRL+SHIFT+HOME Extend the selection to the beginning of the worksheet 
CTRL+SHIFT+arrow 
key 

Extend the selection to the last nonblank cell in the same 
column or row as the active cell 

SHIFT+F8 Add another range of cells to the selection; or use the arrow 
keys to move to the start of the range you want to add, and then 
press F8 and the arrow keys to select the next range 

Entering and editing the data in excel 
 To enter the data, click the cell and type the data. The data will be appeared in current 

cell as you type and it also appears in formula bar. After entering the data in a cell use 
arrow keys to move to next cells.  
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 For editing the data in a cell press F2 and edit it. Otherwise select the cell and edit the 
data in the formula bar. 

Moving and Copying of cells 
 Select the cells you want to move or copy.  
 To Move cells   Click Cut on the Home ribbon  and  select the upper-left cell of the paste 

area. And click paste button 
 To Copy cells   Click Copy and select the upper-left cell of the paste area. And click paste 

button 
Insert blank cells, rows, or columns 

1. Do one of the following:  
Insert new blank cells    Select a range of cells where you want to insert the new blank 
cells. Select the same number of cells as you want to insert. 
Insert a single row  Click a cell in the row immediately below where you want the new 
row. For example, to insert a new row above row 5, click a cell in row 5.  
Insert multiple rows  Select rows immediately below where you want the new rows. 
Select the same number of rows as you want to insert.  
Insert a single column  Click a cell in the column immediately to the right of where you 
want to insert the new column. For example, to insert a new column to the left of 
column B, click a cell in column B. 
Insert multiple columns  Select columns immediately to the right of where you want 
to insert the new columns. Select the same number of columns as you want to insert.  

2. Right click the mouse and select Cells, Rows, or Columns.  
Delete data from  excel. 
Delete cells, rows, or columns 

1. Select the cells, rows, or columns you want to delete.  
2. Right click and then click Delete.  
3. If you are deleting a range of cells, click Shift cells left, Shift cells up, Entire row, or 

Entire column in the Delete dialog box.  
Delete sheets 

1. Select the sheets you want to delete.  
2. On the Edit menu, click Delete Sheet.  

Changing Column Width and Row Height 
Adjusting column widths 

By default, Excel's columns are 8.43 characters wide, but each individual column can be 
enlarged to 240 characters wide. 
We can adjust the column width to required size 

To Manually Adjust a Column Width: 
 Place your mouse pointer to the right side of the gray column header. 
 The mouse pointer changes to the adjustment tool (double-headed arrow). 
 Drag the Adjustment tool left or right to the desired width and release the mouse 

button. 
To AutoFit the Column Width: 
 Place your mouse pointer to the right side of the column header. 
 The mouse pointer changes to the adjustment tool (double-headed arrow). 
 Double-click the column header border. 
 Excel "Auto Fits" the column, making the entire column slightly larger than the 

largest entry contained in it. 
Adjusting row height 

By default, the row height in excel is 12.75 points. Changing the row height is very much 
like adjusting a column width.  

 

mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/Office10/1033/xlmain10.chm::/html/xlhowCopycells.htm##
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/Office10/1033/xlmain10.chm::/html/xlhowCopycells.htm##
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/Office10/1033/xlmain10.chm::/html/xlnschowInsertcolumns.htm##
mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/Office10/1033/xlmain10.chm::/html/xlhowDeleterowsandcolumns.htm##


 

37 UG-GFC-Basic Computer Skills 

 

To Adjust Row Height of a Single Row: 
 Place your mouse pointer to the lower edge of the ro   w heading you want to 

adjust. 
 The mouse pointer changes to the adjustment tool (double-headed arrow). 
 Drag the Adjustment tool up or down to the desired height and release the 

mouse button. 
To AutoFit the Row Height: 

 Place your mouse pointer to the lower edge of the row heading you want to 
adjust. 

 The mouse pointer changes to the adjustment tool (double-headed arrow). 
 Double-click to adjust the row height to "AutoFit" the font size. 
 Excel XP "AutoFits" the row, making the entire row slightly larger than the 

largest entry contained in the row. 

5. Discuss cell referencing? 
Cell reference indicates how the cell address is referenced when it is used in the formula. In 
excel we find three different cell references. Those cell references are explained below: 
Relative reference: 
When a formula is copied from one part of the worksheet to the other, the address of the cell 
changes, relative to where it has been copied. This ability to adjust a formula from one location 
to another is called ‘Relative Addressing’. The formula is always adjusted relative to its 
location. 
Absolute reference: 
An absolute address points to only one address. It does not change even though the position of 
the cell containing the formula changes. That means whenever an absolute address is used, it 
instructs the spreadsheet program not to update the address if the formula is to be copied or 
moved. 
Mixed reference: 
In absolute reference both row and column are fixed. When either the row remains constant 
and the column changes or the column remains constant and the row changes, it is called a 
mixed addressing method. In other words, mixed mode referencing is a combination of relative 
and absolute address. 
  

6. Explain Formatting features in Excel? 
Ms-Excel provides the following options  

 
Number:Formatting numbers include the options like adding thousand separator (,) , currency 
symbol ($)  or adjusting the number of digits after decimal point. choose font on ribbon from 
home menu 
 
Alignment: Data in cells can be aligned with option alignment on ribbon from home menu  
or we can use the key board short cuts as follows:   

Command  Meaning  
Ctrl + R To align right 
Ctrl + L To align left 
Ctrl + C To align center 

Text in the cells can be oriented at a give angle and it wrapped or shrink to fit 
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Font: Data can be formatted, by changing its font, size, color, style. For this we choose font on 
ribbon from home menu or use the following key board shortcuts. 
     

Command  Meaning 
Ctrl + shift + F To change the font 
Ctrl + shift + p  To change the size 
Ctrl + B To make selection bold 
Ctrl + I To make selection italic 
Ctrl + U To underline the selection 

Border: Cells of the sheet can be made to have different kinds of borders, i.e. dotted, dashed or 
solid borders.  
Patterns: The background of each cell can be made to have a background color and different 
patterns.  
Protection: Protection determines the accessibility of the data in the cells. Cells can be locked 
or made hidden.  
Auto formatting: Auto formatting provides several readymade styles. We can select one the 
styles for selected data range. 
 

7. Explain printing of Spreadsheet in detail? 
In MS Excel there are many features available for 

printing a document which are available from print fly-out 
menu of Office Button. 

It contains Print Preview, modify margins, change 
the page orientation, use the Scale to Fit feature, use the 
Print Titles command, and insert breaks. 
 
To view the spreadsheet in Print Preview: 

 Left-click the Microsoft Office button. 
 Select Print. 
 Select Print Preview. The spreadsheet will appear in 

Print Preview view. 
Click the Close Print 

Preview button to return to the 
Normal View. 
To make previewing your spreadsheet 
easier, add the Print 
Preview command to the Quick Access 
toolbar. 
More about Print Preview 
In Print Preview, there are options such 
as print, pagesetup, zoom, etc., you can 
see how the spreadsheet will appear in 
printed format. 
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To modify margins, column width, or row height while in Print Preview: 

 Click the Print Preview command 
on the Quick Access toolbar, or 
select Print Preview from the 
Microsoft Office button menu. The 
spreadsheet opens in Print Preview 
mode. 

 Hover your cursor over one of 
the black margin markers until 
a double arrow appears. 

 
 Left-click and drag the marker to the 

desired location. The change will be 
reflected in the spreadsheet. 

To modify margins: 
 Select the Page Layout tab. 
 Left-click the Margins command. 
 Choose one of the pre-defined settings, or enter custom margins. 
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To change page orientation: 

 Select the Page Layout tab. 
 Left-click 

the Orientation command. 
 There are two orientations 

Portrait or Landscape. 
Portrait orients the page vertically, 
while Landscape orients the 
page horizontally. 
 
To use Scale to Fit: 

 Select the Page Layout tab. 
 Locate the Scale to Fit group. 
 Enter a specific height and width, or use the percentage field to decrease the 

spreadsheet by a specific percent. 
Scale to Fit is a useful feature that can help you format spreadsheets to fit on a page. 
To change the paper size: 

 Select the Page Layout tab, Click the Size command. 
 Select a size option from the list. 

To define a print area: 
 Left-click, then drag your mouse to select the cells you wish to print. 

 Click the Print 
Area command, 
choose Set Print 

Area. 
 Now, only the selected 

cells will print. You 
can confirm this by 
viewing the 
spreadsheet in Print 
Preview. 

To return to the default setting, which is the entire worksheet, click the Print Area command, 
then select Clear Print Area. 
To insert a break: 

 Select a cell below where you want the break to appear. 
 Select the Breaks command. 
 Select Insert Break. 

Click Print Preview to confirm that the break appears in the correct place in your spreadsheet.  
To use the Print Titles command: 



 

41 UG-GFC-Basic Computer Skills 

 

This is an important command to be familiar with if you intend to print your 
worksheets. It allows you to select specific rows and/or columns that will be repeated 
on each printed sheet. Imagine how difficult it would be to read page 48 of a printed 
spreadsheet if the column and row headings only appeared on the first page. 
 Select the Page 

Layout tab. 
 Click the Print 

Titles command. The 
Page Setup dialog box 
appears. 

 Click the icon at the 
end of the field. 

 Select the first row in 
the spreadsheet that you want to appear on each printed page. 

 
 Repeat for the column, if necessary. 
 Click OK. 

To print from the Microsoft Office button: 
 Left-click the Microsoft Office button. 
 Select Print Print. The Print dialog box appears. 
 Select a printer if you wish to 

use a printer other than the 
default setting. 

 Click Properties to change any 
necessary settings. 

 Choose whether you want to 
print specific pages, all of the 
worksheet, a selected area, the 
active sheet, or the entire 
workbook. 

 Select the number of copies 
you'd like to print. 

 Click OK. 
 

8. Discuss in detail about Functions in Excel? 
A function is a pre-defined formula that helps to perform common mathematical 

functions. Functions save our  the time of writing lengthy formulas. we can use an Excel 
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function called Average,  to quickly find the average of range of numbers. Or we can use 
the Sum function to find the sum of a cell range. Excel contains many different functions. 
Each function has a specific order, called syntax. We must follow the syntax of function 
to work correctly. 
Syntax Order: 
1. All functions begin with the = sign. 
2. After the = sign define the function name (e.g., Sum). 
3. One or more arguments-numbers, text or cell references-enclosed by 

parentheses. If there is more than one argument, separate each by a comma. 
An example of a function with one argument that adds a range of cells, B3 through B10:  

 
An example of a function with more than one argument that calculates the average of 
numbers in a range of cells, B3 through B10, and C3 through C10: 

 
Excel Function Wizard 
We need not to remember the complex syntax for each function; it is easy to use all the 
functions with FUNCTION WIZARD in excel.  
To activate 

 We can either click on this fx button or 
 We can choose Formulas |Insert Function, 

Types of Functions in Excel: 
Excel supports wide variety of functions. Some of them are listed below: 
Arithmetic (math & trigonometric) functions 
Statistical functions 
Date and Time functions. 
Text functions 
Database functions 
Financial functions etc. 
Mathematical & Trigonometric Functions:  
ABS -Returns the absolute value of a number 
CEILING -Rounds a number to the nearest integer or to the nearest multiple of significance 
FLOOR -Rounds a number down, toward zero 
EXP -Returns e raised to the power of a given number 
FACT -Returns the factorial of a number 
SQRT -Returns a positive square root 
MOD -Returns the remainder from division 
PI -Returns the value of pi 
POWER -Returns the result of a number raised to a power 
RAND -Returns a random number between 0 and 1 
SIN -Returns the sine of the given angle 
COS -Returns the cosine of a number 
TAN -Returns the tangent of a number 
Statistical  functions 
 SUM - summation adds a range of cells together. 
 AVERAGE - average calculates the average of a range of cells. 
 COUNT - counts the number of chosen data in a range of cells. 

http://office.microsoft.com/en-in/excel-help/redir/HP010342132.aspx?CTT=5&origin=HP010342656
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http://office.microsoft.com/en-in/excel-help/redir/HP010342816.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342899.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342333.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342945.aspx?CTT=5&origin=HP010342656
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 MAX - identifies the largest number in a range of cells. 
 MIN - identifies the smallest number in a range of cells. 
 MEDIAN-Returns the median of the given numbers 
Text Functions 
CHAR function-Returns the character specified by the code number 
CONCATENATE function -Joins several text items into one text item 
LEN function-Returns the number of characters in a text string 
LOWER function-Converts text to lowercase 
UPPER function-Converts text to uppercase 
 
Date and time functions 
NOW  -Returns the serial number of the current date and time 
DATE  - Returns the serial number of a particular date 
YEAR  -Converts a serial number to a year 
MONTH  -Converts a serial number to a month 
DATEVALUE  -Converts a date in the form of text to a serial number 
DAY  -Converts a serial number to a day of the month 
TIME  -Returns the serial number of a particular time 
HOUR  -Converts a serial number to an hour 
MINUTE  -Converts a serial number to a minute 
SECOND  -Converts a serial number to a second 
TODAY  -Returns the serial number of today's date 
WEEKDAY  -Converts a serial number to a day of the week 
Logical functions 
AND  - Returns TRUE if all of its arguments are TRUE 
IF  - Specifies a logical test to perform 
NOT  - Reverses the logic of its argument 
OR  - Returns TRUE if any argument is TRUE 
 

9. Define Presentation? Explain Features of Powerpoint 
presentation? 

Microsoft PowerPoint is a part of the Office software. It is a graphics application. A 
presentation is a combination of slides, handouts, notes, and outlines all in one file. We can add 
text, graphics, photos, clip art, sound and video to our slides.  
PARTS IN POWERPOINT WINDOW 
The PowerPoint Window has toolbars and panes to help us for creating presentations 
quickly.  

 Office button: Opens the Office menu, from which you can open, save, print, and start 
new presentations. 

 Quick Access Toolbar: A small toolbar next to the Office button contains shortcuts for 
some of the most common commands. 

 Title bar: Identifies the PowerPoint program running and the name of the active 
presentation.  

 Minimize button: Shrinks the application window to a bar on the taskbar; you click its 
button on the taskbar to reopen it. 

 Maximize/Restore button: If the window is maximized (full screen), click will changes 
it to windowed (not full screen) and vice versa. 

 Close button: Closes the application. 
 Ribbon: Functions as a combination of menu bar and toolbar, offering tabbed "pages" of 

buttons, lists, and commands. 

http://office.microsoft.com/en-in/excel-help/redir/HP010342259.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342288.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342650.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342672.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342981.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342726.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342403.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010343045.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342701.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342404.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342406.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342955.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342580.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342694.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342874.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342958.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010343015.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342169.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342586.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342725.aspx?CTT=5&origin=HP010342656
http://office.microsoft.com/en-in/excel-help/redir/HP010342743.aspx?CTT=5&origin=HP010342656
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 Presentation window: Where active PowerPoint slide(s) appear where you work on 
the slide. 

 Status bar: Reports information about the presentation and provides shortcuts for 
changing the view and the zoom. 

Basic Terminology 
Slide: A slide is a single page of a presentation created with software such as PowerPoint. A 
presentation is composed of several slides. The best presentations use approximately ten to 
twelve slides to get the message across 
Speaker Notes / Notes Page: Speaker notes, or notes pages are notes added to the 
presentation slides as a reference for the presenter. An area of a PowerPoint slide that is 
hidden during the presentation is reserved for notes for the speaker.  
Handouts: Printed copies of the presentation for the audience to refer to during and after the 
slide show. 
Presentation: a set of slides or handouts that contains information you want to convey to an 
audience. 
Normal View: PowerPoint's default view that displays the Slide pane, the Notes pane, and the 
Slides/Outline pane 
Active Slide: The slide currently selected or displayed. 
Slide Layout: Prearranged sets of placeholders for various types of slide content.  
Theme: Formatting feature that applies a background, colors, fonts, and effects to all slides in a 
presentation. 
Clip Art: Pre-drawn artwork, photos, animations, and sound clips that you can insert into 
your files. 
Template: A presentation that is already formatted with a slide design and may also 
include sample text to guide you in completing the presentation. 
Slide Master: A slide that contains the appearance of all slides in a presentation.  
Transitions: The visual effects used when one slide moves off of the screen and another 
moves onto the screen. 
Animate: To apply movement to text or an object to control its display during the 
presentation. 
Custom Show: A show in which you specify the slides and the order in which the slides 
appear during the presentation. 
 

10. Explain Preparation of Presentation? 
To open Microsoft PowerPoint, First click on "Start" button. Next click on All Programs. 

Now click on Microsoft PowerPoint, this will start the program. 
Alternatively, look on your Desktop for an icon shortcut to Powerpoint, and double-click on it. 

CREATING PRESENTATION: 
When you start PowerPoint 2007, a new, blank presentation opens. If you start with a 

blank presentation, you can choose a theme, a background color for the slides, and fonts, and 
you can fashion your own slide layouts. When you create a presentation with a template, all 
design decisions are made for you. You get ready-made background colors, fonts, and slide 
layouts. 

PowerPoint shows you a blank presentation each time you open the program. Or to 
create a new, blank presentation, you can follow these steps:  
1 Click the Office button. 
New to PowerPoint 2007, the Office button is the unlabeled, circle with the multi-colored logo 
in it, in the far upper-left corner of your PowerPoint window.  
2 Choose New on the drop-down list. 
You see the New Presentation dialog box. 
3 Double-click Blank Presentation. 

http://presentationsoft.about.com/od/powerpoint101/ss/slide_views_5.htm
http://presentationsoft.about.com/od/powerpoint2010/ss/100207powerpoint2010-slide-views_4.htm
http://presentationsoft.about.com/od/powerpointinbusiness/tp/071231resolutions.htm
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Slide Transactions. 
Slide transactions include creating a slide, deleting a slide, copying, saving and printing a slide.  
Creating a slide In a blank presentation Home | new slide allows us to create a new slide with 
desired layout. 
Deleting a slide Select the slide you want to delete and press del button on key board.  
Copying a slide Select the slide and choose copy and paste options from home ribbon 
Saving a slide Saving all slides of presentation is done with office button | save option. Here 
the file name extension is .pptx 
Numbering a slide. For this select Insert | slide number. Now in the dialog box click the check 
box insert slide number. The effect can be applied to only one slide or all slides.  
Print a slide Printing a slide(s) is done with office button| print option. We can print the slides 
along with their note page. 
Steps to Save, Open & Close a Presentation. 
Save a presentation 

1. From the office button, click Save   (or) Press ctrl +s on key board          (or) 
Click save icon on quick access tool bar. 

2. select the drive and folder and enter the name of the presentation in the dialog box 
Open a presentation 

1. From the office button.  Click open (or) 
Press ctrl +o on key board        (or) 

2. select the drive and folder and double click the name of the presentation in the 
dialog box 

Close a presentation 
To close a presentation,  choose close option form office button.  

Animating text and objects 
There are two ways to animate text and objects: Preset Animation and Custom 

Animation. Although Preset Animation is relatively simpler, we strongly recommend Custom 
Animation because it allows more control over animation. The instructions given below are 
related to Custom Animation only. 
To apply a custom animation effect in Office PowerPoint 2007, do the following:  

1. Select the text or object that you want to animate. 
2. On the Animations tab, in the Animations group, click Custom Animation. 
3. In the Custom Animation task pane, click Add Effect, and then do one or more of the 

following: 
o To make the text or object enter with an effect, point to Entrance, and then click 

an effect. 
o To add an effect, such as a spin effect, to text or an object that is already visible 

on the slide, point to Emphasis, and then click an effect. 
o To add an effect that makes text or an object leave the slide at some point, point 

to Exit, and then click an effect. 
o To add an effect that makes text or an object move in a specified pattern, point to 

Motion Paths, and then click a path. 
4. To specify how the effect is applied to your text or object, right-click the custom 

animation effect in the Custom Animation list, and then click Effect Options on the 
shortcut menu. 

5. Do one of the following: 
o To specify settings for text, on the Effect, Timing, and Text Animation tabs, 

click the options that you want to use to animate the text. 
o To specify settings for an object, on the Effect and Timing tabs, click the options 

that you want to use to animate the object. 
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11. Explain Slide Transitions in powerpoint? 
Slide Transition. 
Transitions determine the effects applied when you move from one slide to another during an 
on-screen presentation. 

1. On the left side of the slide window, in the pane that contains the Outline and Slides 
tabs, click the Slides tab. 

2. Select the slide thumbnails of the slides that you want to apply slide transitions to. 
3. On the Animations tab, in the Transition To This Slide group, click a slide transition 

effect. 

To see more transition effects, in the Quick Styles list, click the More button .  
4. To set the slide transition speed between the current slide and the next slide, in the 

Transition To This Slide group, click the arrow next to Transition Speed, and then 
select the speed that you want. 

5. In the Transition To This Slide group, click Apply to All. 
Add different slide transitions to the slides in your presentation 

1. On the left side of the slide window, in the pane that contains the Outline and Slides 
tabs, click the Slides tab, and then click a slide thumbnail. 

2. On the Animations tab, in the Transition To This Slide group, click the slide transition 
effect that you want for that slide. 

To see more transition effects in the Quick Styles list, click the More button .  
3. To set the slide transition speed between the current slide and the next slide, in the 

Transition To This Slide group, click the arrow next to Transition Speed, and then 
select the speed that you want. 

4. To add a different slide transition to another slide in your presentation, repeat steps 2 
through 4. 

Add sound to slide transitions 
1. On the left side of the slide window, in the pane that contains the Outline and Slides 

tabs, click the Slides tab, and then select the slide thumbnails that you want to add a 
sound to. 

2. On the Animations tab, in the Transition To This Slide group, click the arrow next to 
Transition Sound, and then do one of the following: 

o To add a sound from the list, select the sound that you want.  
o To add a sound not found on the list, select Other Sound, locate the sound file 

that you want to add, and then click OK. 
3. To add sound to a different slide transition, repeat steps 2 and 3. 

 

12. Explain Printing of Presentation/taking handouts? 
PowerPoint allows you to print your presentation as slides, notes, handouts, or even outlines. 
Choose office button then click Print... from it. This will bring up the "Print" dialog box 

 In the "Print what" pull-down menu, choose the item you would like to print.  
 If you choose "print slides", you will get is one slide per page. It is useful if you wish to 

print transparencies of your slides as a backup in case of a system failure.  
 If you choose "print handouts",  

you have the option to choose the number of slides (2/3/4/6/9/12 slides per 
page) you want to print on each page.  
The "3 slides per page" option is particularly useful because it displays small 
versions of your slides on the left half of the page, and leaves space for your 
audience to write on notes on the right side of the page. 

 If you choose "print outline view" you will get only the text of your slides (as it appears 
in outline view) but none of the graphics or animation. 
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13. Define Internet, www, client and server, Internet service 
provider? 

Internet: 
The internet is the largest computer network in the world, connecting millions of 

computers. A network is a group of two or more computer systems linked together. 
The foundation of the internet began in 1969, when the US Department of Defense 

created ARPAnet, a project to allow military personnel to communicate with each other in an 
emergency.By 2012, the number of internet users worldwide reached 2.4 billion—about one 
third of the world's population.To store all of the information on the internet you would need 
over 1 billion DVDs or 200 million Blu-ray discs. 
 
The World Wide Web (WWW) 

When most people think of the internet, the first thing they think about is the World 
Wide Web. Nowadays, the terms "internet" and "World Wide Web" are often used 
interchangeably—but they're actually not the same thing. The internet is the physical 
network of computers all over the world.  The World Wide Web is a virtual network of web 
sites connected by hyperlinks (or "links"). Web sites are stored on servers on the internet, so 
the World Wide Web is a part of the internet. 
 
Servers: 

A server is a computer program that accepts and responds to requests made by 
another program, known as a client. Any device that runs server software could be considered 
as a server as well. Servers are used to manage network resources. 
 
Client: 
A client Is the one which gets served by the server. user can send request from an client 
software to the server upon processing the request server send the response to the client. 
 
Internet Service Provider:  

Internet Service Provider (ISP) is the industry term for the company that is able to 
provide you with access to the Internet, typically from a computer. If you hear someone talking 
about the Internet and they mention their "provider," they're usually talking about their ISP. 
An ISP is your gateway to the Internet and everything else you can do online.  
 

14. Define Web Browser and explain different types of web 
Browser? 

 A web browser is the tool that you use to access the World Wide Web. The browser's 
main job is to display web pages. It also lets you create Bookmarks for sites you like, so that 
you can easily find them again later.  

PCs come with Internet Explorer, and Macs come with Safari. If you prefer to use a 
different browser, you can download Firefox, Google Chrome, or Opera. All of these browsers 
are free. Internet.  

 
Accessing web browser: 
1. Click the Windows “Start” button in the lower left corner of your screen to launch the Start 
menu. 
2. Click the “All Programs” button to load a list of all the programs currently available for use 
on your computer. 
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3. Click “Internet Explorer” on the All Programs menu. Internet Explorer is the native Internet 
browser that comes with all Windows computers. After you click “Internet Explorer,” your 
computer loads the program so you can begin browsing the Internet.  
Downloading a web pages: 

If you're on a desktop computer, saving a web page is dead simple. Just open up your 
browser, navigate to the page, and go to File > Save Page As. Save it as "Web Page, Complete" 
somewhere in your documents. You'll get an HTML file and a folder full of images and other 
data contained within-don't delete this. 
Printing web pages: 
1.Click the file menu button and then click Print. 
2.In the Print Preview window that opens, adjust settings for what you're               about to print, 
if necessary. See Print window settings below for information on what settings can be changed.  
3.Click Print to start printing.  

 
Following are popular web browsers: 
 
Google Chrome: 

Google is most popular browser among existing browser. Focuses on enhanced 
performance of web applications. Hundreds of useful extensions can be downloaded for free 
from Chrome Store and can be used for personal use. 

A large array of apps and add-ons available at Chrome Store. These adds a considerable 
amount to the browsing experience of the users. Some of the features are Private browsing, 
Fast Startup, Phishing/ Malware Filter  
 
Mozilla Firefox Mozilla Firefox: 

A web browser designed for simplicity, security, extensibility yet flexibility and power. 
Available for Linux and android as well. There are lots of plugins and extensions with some 
powerful developer tools. 

Constant updates, high performance delivered and customizable interface is a bliss for 
advanced users. Firefox allows an open architecture which accepts the installation of themes 
and extensions. Themes give the browser a customizable new look. Developers can write 
extensions to make the browser perform functions as desired like check your Gmail account 
when you open the browser, or block all ads. 
     
Opera Web Browser: 

Constantly evolving and improving and the most popular mobile browser, opera has 
came a long way from being a browser to a full fledged internet suite. 

Free fast browser with good support for updates. Features like page zoom and 
developer shortcuts allow users to have unique experience. There are some compatibility 
issues found in certain websites but with constant updates these problems are scarce. 
 
Safari Web Browser: 

Safari is a web browser developed by Apple inc. It is the most popular browser with 
MAC users. 

Safari is a clean browser, very fast based on the WebKit rendering engine. Safari comes 
with the features you want in a modern browser, like tabbed browsing, popup blocking and 
built-in search functionality. It also has one of the best RSS-reading feature available online, it 
is easier to keep track a number of websites than using bookmarks. 
 
Internet Explorer:  
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Internet Explorer by Microsoft is the default browser for Windows operating system. Its 
still very popular with many internet users. Startup speed is a big issue with internet explorer.  

Internet Explorer is still considered to be falling behind in the race, but latest editions 
promise fast load, packed with latest features.  

 

15. Define Network? What are the different types of Networks? 
Network: A network is a collection of computers, servers, mainframes, network devices, 
peripherals, or other devices connected to one another to allow the sharing of data. There are 
three main types of computer networks:  
 1. Local Area Network (LAN):  

A LAN is two or more connected computers sharing certain resources in a relatively 
small geographic location, often in the same building. Examples include home networks and 
office networks. 
2. Metropolitan Area Network (MAN) 

These types of networks are larger than LANs but smaller than WANs – and incorporate 
elements from both types of networks. MANs cover an entire geographic area (typically a town 
or city, but sometimes a campus). Ownership and maintenance is handled by either a single 
person or company. 
3. Wide Area Network (WAN) 

Slightly more complex than a LAN, a WAN connects computers together across longer 
physical distances. This allows computers and low-voltage devices to be remotely connected to 
each other over one large network to communicate even when they’re miles apart. 

The Internet is the most basic example of a WAN, connecting all computers together 
around the world. Because of a WAN’s vast reach, it is typically owned and maintained by 
multiple administrators or the public. 
 

16. What are the Applications of Internet? 
 The internet has many few major applications like electronic mail services, web browsing, 

and peer to peer networking. The use of email increases because of their several features 
like attachments, messages, data usage. 

 The attachment feature such as word documents, excel sheets, and graphical media is 
possible because of Multipurpose Internet Mail Extensions but the result is traffic volume 
caused by mail is calibrated in terms of data packets in the network. 

 Electronic mail services became a vital part of personal and professional 
communication method and its time and cost consuming.  

 The web browser is a critical application of the internet and is highly commercial 
dominated by Microsoft and highly influenced by WWW – World Wide Web. 

 The web browser is free and available as an open-source model that enriches the minds 
of future generations.  

 This P2P networking is a dynamic method that is based on the exchanging of physical 
resources like hard drives, files, processors and other intelligent features. 

Here are the top 8 internet applications listed below: 

http://www.networkworld.com/article/3001389/wide-area-networking/the-challenges-of-creating-and-enforcing-policies-across-the-wan.html
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1. Smart Home 

Smart Home has become the evolutionary step in residential and developing as common 
as smartphones. It is a special feature of Google and now deployed in many areas to make life 
convenient and user-friendly. The smart home is designed to save time, money and energy.  
2. Electronic Devices 

The electronic devices like wearables are installed with different sensors and software 
which gather data and information of the user where data is processed to give required info 
about the user. The devices mainly used to monitor fitness, entertainment, and health. They 
mostly work on ultra-low power and available in small sizes. 
3. Automated Digital Technology 

The automated digital technology has concentrated on the optimization of vehicles and 
their internal functions. the automated car is designed with special features that give a comfort 
zone to passengers with onboard sensors and internet establishment. The popular companies 
like Tesla, Apple, BMW, Google is yet to aboard their revolution in the automobile industry by 
installing excellent features. 
4. Industrial Internet 

The industrial internet is investing in industrial engineering with Artificial intelligence 
and data analytics to build brilliant machines. The important moto is to build smart machines 
that are accurate and compatible with a human. It holds vast potential with good quality and 
reliability. The applications are deployed for tracing the goods to be delivered, real-time data 
regarding retails and supplies that increase the efficiency of supply chain and productivity of 
the business. 
5. Smart City  

A smart city is another major implementation of the internet which is employed for 
smart surveillance, water distribution, automatic transportation, environment monitoring. 
People are prone to pollution, improper supplies and shortage of sources, and irregular traffic 
flow are solved by the installation of traffic sensors, and the app is developed to report the 
municipal systems. Citizens can able to diagnose simple malfunctions in meter and can report 
to the electricity system via electricity board applications or websites and they can also find 
available slots for vehicle parking easily in sensor systems. 
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6. Smartphones 
Smartphones are also used for retailers and customers to stay connected for their 

business transactions even out of the store. They have using Beacon technology to help 
business people to provide smart service to the client. They can track the products and 
enhance the store dashboard and deliver premium order before the scheduled date even in 
congested traffic areas. 
7. Smart Grids 

The idea applied in smart grids is to gather data in an automated way to analyze the 
attribute of electricity. consumers to improve the efficiency and economics of usage. Smart 
grids can easily detect the power outage and shortage quickly and fix it shortly. 
8. Major Application 

Another major application of the internet is in healthcare as it is smart medical systems 
installed to diagnose and cure the disease at an earlier stage. Many machine learning 
algorithm is used in image processing and classification to detect the abnormalities of the fetus 
before birth. The main aim applied in the medical field is to provide a healthier life to all by 
wearing the connected devices. The gathered medical data of patients made the treatment 
easier and monitoring device is installed to track the sugar and blood pressure.  
 

17. Discuss Internet Connection trouble shooting Problems? 
Troubleshooting Steps 
Try the following series of steps, in order, to see if this fixes your problem. You can stop when 
you resolve the issue(s) you are having. 

1. Check the network icon (or wireless connection settings) to see if you have Internet 
access. Ensure that your network adapter is not turned off. 

2. Check for changes to proxy settings. 
3. Check the network cables if your computer is wired to the router. 
4. Reset your router. 
5. Check your firewall or security software.  
6. Check your browser access issues  

The next few sections will expand these steps into a series of instructions. Where Linux is 
indicated, I've based these on Linux Mint, the version I'm currently working with.  
Check the Network 
Check the network connection on your computer. This connects other computers in your 
network as well as providing access to the Internet via your ISP. 
Depending upon your operating system and your settings, there may be a network icon at the 
top or bottom of the screen or it may be hidden. 
Your Internet connection can include either or both wired and wireless connections  
Whichever you're using, there is likely a router involved, whether it is your home network or a 
public network such as at a coffee shop or a business network, or a community wireless 
network). 
If you're not using your own network, you'll need to speak to the person responsible for that 
network for details on how to fix any issues. 
Check the Wireless Settings 
If you're connected wirelessly you'll see a listing of available wireless networks. The wireless 
network you're currently logged into (if any) should be indicated. Most networks are protected 
by a security protocol and a password. 

 You'll need to verify that your connection is strong enough and that the settings don't 
indicate any problems. 

 If you're having difficulties connecting or if there is a problem with the connection, 
you'll need to diagnose it. 
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 If you don't control the network, you'll need to ask for the password and may need 
additional help diagnosing the problems. 

 Some public networks are heavily used and can be very slow regardless of whether 
everything is working fine. 

Check the Wired Settings 
If you're connected via CAT5 or CAT6 network cables, you should check the following:  

 Check the cables to ensure that they aren't unplugged or damaged. 
 Be sure that the network adapter isn't disabled. 

You may need to reset the router then reboot your computer. 
 

18. What is Search Engines, Explain Various Search Engines? 
A search engine is a web based tool that enables users to locate information on the 

www. Popular examples of search engine are google, yahoo! And MSN search, ASK etc., 
1. Google: No need for further introductions. The search engine giant holds the first place in 
search with a stunning difference of 66% from second in place Bing. Google is also dominating 
the mobile/tablet search engine market share with 93%! 
2. Bing: Bing is Microsoft’s attempt to challenge Google in the area of search, but despite their 
efforts they still did not manage to convince users that their search engine can produce better 
results than Google. 
3. Yahoo: Since October 2011 Yahoo search is powered by Bing. Yahoo is still the most popular 
email provider and according to reports holds the fourth place in search. 
4. DuckDuckGo: Has a number of advantages over the other search engines. It has a clean 
interface, it does not track users, it is not fully loaded with ads and has a number of very nice 
features (only one page of results, you can search directly other web sites etc).  

I am sure that some of the features of duckduckgo will be used by other search engines 
and with some proper funding duckduckgo can get a decent search engine market share.  
 

19. What is URL? 
Every document on the Web has a unique address. This address is known 

as Uniform Resource Locator (URL). 
Several HTML/XHTML tags include a URL attribute value, including hyperlinks, inline 

images, and forms. All of them use the same syntax to specify the location of a web resource, 
regardless of the type or content of that resource. That's why it is known a Uniform Resource 
Locator. 

A URL is made of up several parts, each of which offers information to the web browser 
to help find the page. It is easier to learn the parts of a URL, if you look at the example URL 
given below, there are three key parts: the scheme, the host address, and the file path. The 
following section will discuss each of them: 
https://sucomputersforum.com/previous-papers/ 
 
The scheme identifies the type of protocol and URL you are linking to and therefore, how the 
resource should be retrieved. For example, most web browsers use Hypertext Transfer 
Protocol (HTTP) to pass information to communicate with the web servers and this is the 
reason a URL starts with http://. 
There are other schemes available and you can use either of them based on your requirement: 
https:// 
ftp:// 
file:// 
 

https://sucomputersforum.com/previous-papers/
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20. What is Domain Name? 
A domain name is the part of your Internet address that comes after "www". For 

example, in sucomputersforum.com the domain name is tutorialspoint.com. 
A domain name becomes your Business Address so care should be taken to select a domain 
name. Your domain name should be easy to remember and easy to type.  
How to Get a Domain Name? 

When you plan to develop a site online, first step is to buy a domain name. This is 
always not necessary that whatever domain name you are looking that is available so in that 
case you will have to opt for any other good domain name. 
 

Once you buy a domain name it is registered and when domain names are registered 
they are added to a large domain name register, and information about your site − including 
your Internet IP address is stored on a DNS server and your contact information etc. is 
registered with your registrar. 
You can buy domain name from any domain registrar like bigrock, godaddy 
Domain Extension Types 
There are many types of domain extensions you can choose for your domain name. This 
depends on your business nature. 
For example, if you are going to register a domain name for education purpose then you can 
choose .edu extension. 
Below is a reference of the correct usage of certain extensions. But there is no hard and fast 
rule to go for any extension. Most commonly used is .com 

 .com − Stands for company/commercial, but it can be used for any website.  
 .net − Stands for network and is usually used for a network of sites.  
 .org − Stands for organization and is supposed to be for non-profit bodies. 
 .us, .in − They are based on your country names so that you can go for country specific 

domain extensions 
 .biz − A newer extension on the Internet and can be used to indicate that this site is 

purely related to business. 
 .info − Stands for information. This domain name extension can be very useful, and as a 

new comer it's doing well. 

21. What is IP Address? Discuss in Detail? 
Internet Protocol hierarchy contains several classes of IP Addresses to be used 

efficiently in various situations as per the requirement of hosts per network. Broadly, the IPv4 
Addressing system is divided into five classes of IP Addresses. All the five classes are identified 
by the first octet of IP Address. 

 
Class A Address 
The first bit of the first octet is always set to 0 (zero). Thus the first octet ranges from 1 – 127, 
i.e. 

 

http://www.tutorialspoint.com/
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Class A addresses only include IP starting from 1.x.x.x to 126.x.x.x only. The IP range 127.x.x.x 
is reserved for loopback IP addresses. 
The default subnet mask for Class A IP address is 255.0.0.0 which implies that Class A 
addressing can have 126 networks (27-2) and 16777214 hosts (224-2). 
Class A IP address format is thus: 0NNNNNNN.HHHHHHHH.HHHHHHHH.HHHHHHHH 
Class B Address 
An IP address which belongs to class B has the first two bits in the first octet set to 10, i.e.  

 
Class B IP Addresses range from 128.0.x.x to 191.255.x.x. The default subnet mask for Class B 
is 255.255.x.x. 
Class B has 16384 (214) Network addresses and 65534 (216-2) Host addresses. 
Class B IP address format is: 10NNNNNN.NNNNNNNN.HHHHHHHH.HHHHHHHH 
Class C Address 
The first octet of Class C IP address has its first 3 bits set to 110, that is − 

 
Class C IP addresses range from 192.0.0.x to 223.255.255.x. The default subnet mask for Class 
C is 255.255.255.x. 
Class C gives 2097152 (221) Network addresses and 254 (28-2) Host addresses. 
Class C IP address format is: 110NNNNN.NNNNNNNN.NNNNNNNN.HHHHHHHH 
Class D Address 
Very first four bits of the first octet in Class D IP addresses are set to 1110, giving a range of −  

 
Class D has IP address range from 224.0.0.0 to 239.255.255.255. Class D is reserved for 
Multicasting. In multicasting data is not destined for a particular host, that is why there is no 
need to extract host address from the IP address, and Class D does not have any subnet mask.  
Class E Address 
This IP Class is reserved for experimental purposes only for R&D or Study. IP addresses in this 
class ranges from 240.0.0.0 to 255.255.255.254. Like Class D, this class too is not equipped 
with any subnet mask. 
 

22. Explain Using E-Governance Website? 
Definition: E-governance, expands to electronic governance, is the integration 

of Information and Communication Technology (ICT) in all the processes, with the aim of 
enhancing government ability to address the needs of the general public. The basic purpose of 
e-governance is to simplify processes for all, i.e. government, citizens, businesses, etc. at 
National, State and local levels. 
 

In short, it is the use of electronic means, to promote good governance. It connotes the 
implementation of information technology in the government processes and functions so as to 
cause simple, moral, accountable and transparent governance. It entails the access and 
delivery of government services, dissemination of information, communication in a quick and 
efficient manner. 
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Benefits of E-governance 
 Reduced corruption 
 High transparency 
 Increased convenience 
 Growth in GDP 
 Direct participation of constituents 
 Reduction in overall cost. 
 Expanded reach of government 
Through e-governance, the government plans to raise the coverage and quality of 
information and services provided to the general public, by the use of ICT in an easy, 
economical and effective manner. The process is extremely complicated which requires, the 
proper arrangement of hardware, software, networking and indeed re-engineering of all the 
processes to facilitate better delivery of services. 
Types of Interactions in E-Governance 

1. G2G (Government to Government): When the exchange of information and services is 
within the periphery of the government, is termed as G2G interaction. This can be both 
horizontal, i.e. among various government entities and vertical, i.e. between national, state and 
local government entities and within different levels of the entity.  

2. G2C (Government to Citizen): The interaction amidst the government and general 
public is G2C interaction. Here an interface is set up between government and citizens, which 
enables citizens to get access to wide variety of public services. The citizens has the freedom to 
share their views and grievances on government policies anytime, anywhere.  

3. G2B (Government to Business): In this case, the e-governance helps the business class 
to interact with the government seamlessly. It aims at eliminating red-tapism, saving time, cost 
and establish transparency in the business environment, while interacting with government. 

4. G2E (Government to Employees): The government of any country is the biggest 
employer and so it also deals with employees on a regular basis, as other employers do. ICT 
helps in making the interaction between government and employees fast and efficient, along 
with raising their level of satisfaction by providing perquisites and add-on benefits. 
 

E-governance can only be possible if the government is ready for it. It is not a one day 
task, and so the government has to make plans and implement them before switching to it. 
Some of the measures include Investment in telecommunication infrastructure, budget 
resources, ensure security, monitor assessment, internet connectivity speed, promote 
awareness among public regarding the importance, support from all government departments 
and so forth 

E-governance has a great role to play, that improves and supports all tasks 
performed by the government department and agencies, because it simplifies the task on 
the one hand and increases the quality of work on the other. 
Our Telangana state E-Governance Website 
https://it.telangana.gov.in/sectors/e-governance/ 

23. What is email? Explain How to Create an Email account? 
Electronic mail also known as email or e-mail is one of the most commonly used services on 

the Internet, allowing people to send messages to one or more recipients. Email was invented 
by Ray Tomlinson in 1972. 
 

The operating principle behind email is relatively simple, which has quickly made it the 
most popular service used on the Internet. 

As with a traditional postal service, for your message to reach your recipient, all you 
need to know is their address. Its two main advantages over "paper mail" are the speed at 
which the email is sent and the lower cost. 

https://it.telangana.gov.in/sectors/e-governance/
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What's more, email can be used to instantaneously send a message to several people at once. 
Email addresses 
Email addresses (both for senders and recipients) are two strings separated by the character 
"@" (the "at sign"): 

user@domain 
The right-hand part describes the domain name involved, and the left-hand part refers 

to the user who belongs to that domain. One or more mail servers (MX records in the Domain 
Name System) correspond to each domain. 

An email address can be up to 255 characters long and can include the following 
characters: 
     Lowercase letters from a to z; 

    Digits 
    The characters ".","_" and "-" (full stop, underscore, and hyphen)  

In practice, an email address often looks something like this:  
firstname.lastname@provider.domain 
 
To create an account: 

1. Go to www.gmail.com. 
2. Click Create account. 
3. The signup form will appear. Follow the 

directions and enter the required information. 

 
4. Review Google's Terms of Service and Privacy Policy, click the check box, then click 

Next step. 

 
 

5. Here, you'll have an opportunity to set up recovery options. Recovery options are 
helpful if you forget your password or if someone tries to access your account. If you 
don't want to set up recovery options at this time, click Done. 
 

6. Your account will be created, and the Google welcome page will appear. 

http://www.gmail.com/
http://www.google.com/intl/en/policies/terms/
http://www.google.com/intl/en/policies/privacy/
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Just like with any online service, it's important to choose a strong password—in other words, 
one that is difficult for someone else to guess. For more information, check out our Creating 
Strong Passwords lesson. 
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Signing in to your account 
When you first create your account, you will be automatically signed in. Most of the time, 
however, you'll need to sign in to your 
account and sign out when you're done 
with it. Signing out is especially 
important if you're using a shared 
computer (for example, at a library or 
office) because it prevents others from 
viewing your emails. 
 
To sign in: 

1. Go to www.gmail.com. 
2. Type your user name (your 

email address) and password, 
then click Sign in. 
 

To sign out: 
In the top-right corner of the page, 
locate the circle that has your first 
initial (if you've already selected an avatar image, it will show the image instead). To sign out, 
click the circle and select Sign out.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

24. Explain the process of Sending and receiving mails? 
TO send an  Email: 
Open Gmail. Go to https://www.gmail.com/ in your computer's web browser. This will open 
your Gmail inbox if you're logged in. 

 If you aren't logged into your Gmail account, enter your email address and password 
when prompted. 

 Click ＋ Compose. It's in the upper-left side of your Gmail inbox. Doing so opens a "New 

Message" window in the lower-right corner of the page. 
Enter the other person's email address. Click the "To" or "Recipients" text box at the top of 
the New Message window, then type in the email address of the person to whom you want to 
send your email. 

 To add multiple email addresses, type in the first email address, press Tab ↹, and 
repeat with the other email addresses. 

http://www.gmail.com/
https://www.gmail.com/
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 If you want to CC or BCC someone on the email, click either the Cc link or the Bcc link in 
the far-right side of the "To" text field, then type the email address you want to CC or 
BCC into the "Cc" or "Bcc" text field, respectively. 

 Add a subject. Click the "Subject" text field, then type in whatever you want the subject 
of the email to be. 

 Typically speaking, an email subject describes the gist of the email's  
   message in a few words. 

 Enter your email message. In the large text box below the "Subject" text box, type in 
whatever you want for your email message. 
Format your email's text if needed. If you want to apply formatting to your text (e.g., bolding, 
italics, or bullet points), highlight the text to which you want to apply the formatting, then click 
one of the formatting options at the bottom of the email window. 

 For example, to bold a section of text, you would highlight the text and then click B at 
the bottom of the email. 

 

Attach a file if you like. To add a file from your computer, click the "Attachments"    icon 
at the bottom of the window, then select the file(s) you want to upload and 
click Open (or Choose on a Mac). 

 You can add photos in this way, or you can upload photos directly to the email's body by 

clicking the "Photos" icon   at the bottom of the window, clicking Upload, clicking Choose 
photos to upload, and selecting photos as needed. 

 Click Send. It's a blue button in the bottom-right corner of the email window. Doing so 

will send your email to the specified email address(es). 
 
Reading an Email Message 

Gmail automatically and frequently checks for new email messages sent to you, 
whenever your computer or mobile device is turned on and connected to the Internet. If you 
want to manually check for new messages, open your inbox and then click the Refresh button 
above the message list. 

To view all messages you’ve received, click Inbox in the navigation sidebar and then 
click the tab you want to view. Your most important messages should be on the Primary tab; 
other messages might be on the Social, Promotions, Updates, or Forums tabs.  

As shown in figure, all unread messages are displayed in bold against a white 
background. Messages you’ve read are displayed in nonbold type against a shaded background. 
All messages in your inbox show the sender’s name, a message subject, a short snippet of 
message text, and the date on which the message was sent. 

 
Figure: Email messages in the Gmail inbox. 
To read a given message, follow these steps: 

1. From the Gmail inbox, click the tab that contains the type of message you want to view. 
Your most important messages should be on the Primary tab.  

2. Select the message you want to read and click anywhere on that message’s message line.  

https://www.wikihow.com/Send-an-Email-Using-Gmail#/Image:Android7paperclip.png
https://www.wikihow.com/Send-an-Email-Using-Gmail#/Image:Android7image.png
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3. The full text of the message is displayed, as shown in figure You can now reply to, 
forward, or delete the message, as described in the following 
sections.

 
Reading a Gmail message. 

4. To return to the inbox, click the Back to Inbox button above the message. 
 

25. What is Document Collaboration? Discuss? 
Document and file collaboration are the tools or systems set up to help multiple 

people work together on a single document or file to achieve a single final version. Normally, 
this is software that allows teams to work on a single document, such as a Word document, at 
the same time from different computer terminals or mobile devices. Hence, document or file 
collaboration today is a system allowing people to collaborate across different locations using 
an Internet, or "cloud", enabled approach 
 
Example: Googledrive, kolab, drupal  
 

26. Instant Messaging 
Your Gmail screen displays information for your contacts at the bottom of the left pane. 

Here's how to send instant messages from Gmail using this contact list.  
1. Log onto your Gmail account and open Hangouts. 
2. In the contact list, hover over the name of the person you want to message. A box 

appears, with four icons: Send email, Schedule event, Send message, and Start video 
call. 

3. Select Send message. 
4. A chat box with the person's name at the top appears. If you've chatted with them before 

you'll see your previous conversations. 
5. In the Send a message text box, enter a message. 
6. When the other person types a message in return, you'll see an ellipsis icon next to their 

name. When they send a return message, you'll see it in the chat box.  
7. Message back and forth as you would with any other messaging application. 
8. When you're done, in the upper-right corner of the chat box, select X. 

27. What is Netiquettes? Discuss in detail? 
Netiquette is short for "Internet etiquette." Just like etiquette is a code of polite behavior 

in society, netiquette is a code of good behavior on the Internet. This includes several aspects 
of the Internet, such as email, social media, online chat, web forums, website comments, 
multiplayer gaming, and other types of online communication. 
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While there is no official list of netiquette rules or guidelines, the general idea is to respect 
others online. Below are ten examples of rules to follow for good netiquette: 

1. Avoid posting inflammatory or offensive comments online.  

2. Respect others' privacy by not sharing personal information, photos, or videos that 

another person may not want published online. 

3. Never spam others by sending large amounts of unsolicited email.  

4. Show good sportsmanship when playing online games, whether you win or lose.  

5. Don't troll people in web forums or website comments by repeatedly nagging or 

annoying them. 

6. Stick to the topic when posting in online forums or when commenting on photos or 

videos, such as YouTube or Face book comments. 

7. Don't swear or use offensive language. 

8. Avoid replying to negative comments with more negative comments. Instead, break the 

cycle with a positive post. 

9. If someone asks a question and you know the answer, offer to help. 

10. Thank others who help you online. 
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